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1. Introduction 
1.1 Overview 

   The TDL Wintel data acquisition program is a Windows program designed to frequency 
scan a tunable laser, acquire the resulting absorption spectrum and analyze it by performing an 
advanced type of sweep integration.  In this method, we sweep over the full spectral transition or 
group of transitions, then we integrate the area under the transitions using nonlinear least squares 
fitting to the known spectral line shapes and positions.  We do not use frequency modulation 
(FM) techniques.   At the beginning of each scan the software turns the laser on and its frequency 
is swept across the desired transition frequency using a software generated voltage ramp.  At the 
end of the scan the laser current is dropped below threshold to determine the detector voltage 
corresponding to the absence of laser light. The sweep rate can be as fast as 20 kHz for a 150 
point spectrum. This sweep rate is fast enough to strongly suppress the effects of 1/f noise.  
Spectra are co-averaged in a background process while maintaining a 100% duty cycle.  The 
resultant spectrum is fit to a set of Voigt line shape functions which are determined by the 
pressure and temperature. The baseline is treated as a slowly varying polynomial, typically of 
third order. 
 
 There are several advantages to this approach.  First, absolute species concentrations are 
returned from the nonlinear least squares fits.  Calibration is not required.  The species 
concentrations are tied to absolute spectroscopic data such as the HITRAN data base.  Second, 
since the line shape functions are known from theory, they may be calculated given the pressure 
and temperature of the sample.  This is particularly important for applications where the ambient 
pressure and temperature may vary rapidly, for example, in airborne instruments.  Finally, direct 
absorption spectra are not degraded in spectral resolution (like FM spectra) which is quite 
important to the analysis of complex or overlapping spectra. 
 
 This data acquisition software has become a central component of all of our tunable laser 
spectrometers.  Since the software is Windows based, remote operation of our instruments is 
quite feasible.  The TDLWintel program acquires absorption spectra with 100% duty cycle.  
Absolute species concentrations are determined through spectral curve fitting which is 
conveniently interfaced to the HITRAN spectral data base.  The program has several convenient 
frequency locking options as well as methods for suppressing background interference.  The time 
resolution for continuous concentration measurements can be as small as 10 milliseconds.  The 
time resolution for triggered data bursts can be as small as 10 microseconds allowing chemical 
kinetic measurements to be performed during transient events initiated by flash photolysis or 
electric discharge. 
 
 Although this program was developed for the operation of cw lead salt diode lasers, it is 
fully capable of performing high resolution spectroscopic analysis using any light source which 
can be scanned with an external voltage.  The generality of the data acquisition and analysis 
methods implies that this software can be used from the microwave region into the visible as 
long as high spectral resolution is provided. 
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1.2 Hardware Requirements 
 For the software to run properly, certain electronic hardware requirements must be 
satisfied.  The following two components are required: 
 
•   A desktop computer (PC compatible, running Windows 2000 or Windows XP, CPU speed of 
at least 400 MHz, at least 256 MB RAM, at least one PCI bus slot), which runs the laser control 
and data processing program (TDLWintel).  It is the primary means of user interaction with the 
instrument. 
 
•   A fast data acquisition board (National Instruments, www.ni.com, PN: PCI-6110E or PCI-
6111E or PCI-6115E or USB-6251 or USB-6361), which digitizes the detected laser signals and 
sends analog ramp and shutoff signals to the laser. 
. 

    The fast data acquisition board is primarily used to control the laser(s) and 
monitor the detector(s).  There are a variety of slower processes that the software can control or 
monitor with other devices.  The monitoring options include monitoring the sample temperature, 
the sample pressure, and the laser temperature, voltage or current.  The control functions include 
controlling the laser temperature, current or voltage, controlling the sample pressure, and 
controlling various valves and switches.  The software supports a variety of hardware 
configurations to accomplish these functions.  For most of these hardware configurations, a key 
element is a second National Instruments data acquisition board.  Typically this board is the PCI-
6024E or USB-6221 or USB-6229.  The measurement of temperature and pressure are 
particularly important since these parameters are necessary for proper spectroscopic analysis.  If 
temperature and pressure are not measured, they can be set to appropriate values in the software.  
This is acceptable for use in a stable environment like a laboratory.   
 

2. Getting Started 
2.1 Installation 

This section describes how to install the TDLWintel software and the associated NI data 
acquisition boards for the case of legacy PCI cards. 
 
Installing the National Instruments Cards – Legacy PCI Cards 
1) Begin by installing National Instruments software. We are using version 6.92 - otherwise 
known as NIDAQ legacy - not NIDAQ-mx.  Be sure to choose Visual Basic under "Select 
Development Platform" near the end of the installation. It is not good enough to highlight the 
choice – you must see a check mark appear to left of the VB entry. 
 
2) Now, shut down the computer and physically install the NI boards. 
 
3) Run NI test panel - verify that boards work and note board device numbers.  Any values can 
be used, although our convention is 6111 board = 1, first 6024 =2, second 6024 (if used) = 3.  If 
the system has either one or two lasers, then only one 6024 card is needed.  If it has three or four 
lasers, then two 6024 cards are required. 
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Installing TDLWintel 
 If TDLWintel is not already installed on your computer, it can be installed by running the 
installer.  The installer files are located on the Aerodyne FTP site at: 
 
ftp://ftp.aerodyne.com/users/nelson/DropBox/TDLWintel/Wintel Installer 775/ 
 
After obtaining the installer files, run the setup.exe program to complete the installation.  
TDLWintel can be installed in any folder but we recommend installing it in C:\TDLWintel. 
 
 The installer will install the current support files but it will install an old version of the 
TDLWintel executable.  So it is important that you download the latest executable 
(TDLWintel13.18.exe at the time of this writing).  The latest executable can also be found on the 
FTP site at: 
 
ftp://ftp.aerodyne.com/users/nelson/DropBox/TDLWintel/ 
 
 You are encouraged to update TDLWintel as new versions become available.  Simply go 
to the FTP site and download the latest executable.  Updates to TDLWintel are  accomplished 
simply by copying the new TDLWintel executable.  It is not necessary (or recommended) to 
reinstall the entire software package. 
 
IMPORTANT NOTE: 
 Both the installer and the latest executable reside in password protected folders.  To 
access these files you will need the current user name and password.   

 
2.2 Running TDLWintel 
 

The TDLWintel program resides 
in the TDLWintel folder (C:\TDLWintel 
in most cases).   Double click on the latest 
executable: TDLWintel13.18.exe at the 
time of this writing.   The first screen that 
you will see is the hardware configuration 
screen (see Figure 1).  The purpose of this 
screen is to define the hardware 
parameters for your system.  First, you 
should choose an interface style from the 
top section of the menu.  Each style has 
an associated set of hardware parameters 
which are selected in the lower section of 
the menu.  These parameters include the 
number of lasers, the laser type (cw diode 
or pulsed qc), the types of data acquisition 
boards used and the ID numbers for these 
boards.  The ID number for the boards 
can be determined using the software that 
comes with the boards.  

Figure 1. Hardware configuration screen. 
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. 
  
 The two “Board number..” parameters are usually as shown in the figure: 1 for the fast 
board and 2 for the slow board.  However, the requirement is that they match the board numbers 
that were selected when the boards were installed (see discussion above).   When you are happy 
with the selected parameters, click OK and TDLWintel will begin. 

 
The standard TDLWintel 

window should appear and will display 
a green trace that looks like a noisy 
oscilloscope trace.  This is normal 
since no analog input signals have yet 
been connected.  If no trace is evident, 
it may be off scale.  Click on the 
Frame button to the right of the 
window to zoom in on the signal.   If 
there is still no trace or if the trace does 
not vary with time, the program may 
be in Display mode.  The state of the 
program (or mode) is displayed in a 
yellow box on the left of the screen, 
near the top.  It should read Current 
Signal.  If it does not read Current 
Signal, then click on it.  A popup menu 
will appear.  Select Current Signal as 
shown in Figure 2.   
 

 To verify that TDLWintel is operating properly, connect a BNC cable between the first 
analog output (AO0) and the first analog input (AI0) if this is possible with your hardware.  A 
sawtooth wave form should now be visible on the screen.  Again, you may need to click on the 
Frame button to center the wave form in the window.  The wave form should be clean with no 
apparent noise and should be fixed in the display.  It should not float vertically or scroll 
horizontally.  If the waveform is floating, please verify that the program is monitoring input 
channel 0.  This is displayed in a box just below the menu tabs.  The box is labeled A/D.  If it is 
not set to 0, click on the box until it reads 0. 
 
2.3 Setting Up a Frequency Scan 

The observation of a stable waveform demonstrates that the data acquisition system is 
creating a modulation waveform and measuring it synchronously.  The next step is to use the 
modulation waveform to frequency scan the laser.  Before doing this the user MUST verify 
that the modulation waveform will not damage the laser!   The board is capable of delivering 
up to ±10V at the analog output, so proceed with caution. 

 
The modulation waveform can be displayed and modified by choosing Modulation 

waveform… under the Edit menu.  The adjustable waveform parameters are on the left of the 
form and a graph of the selected waveform is on the right.  The Y axis of the graph ranges from –

 
Figure 2.  Control for selecting operating mode. 
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10V to +10V (for cw lasers) or from 0 to +10V for pulsed lasers, corresponding to the available 
output range of the DAC.  The Y axis will also have current labels, showing the range of laser 
current that results from the minimum and maximum DAC voltages.  It is the user’s 
responsibility to be sure that the selected modulation waveform does not exceed the 
acceptable range of input voltage for the laser.   It is safest to begin with a small amplitude 
waveform centered at 0 V and to increase the modulation gradually.  To create a voltage ramp 
that begins at –0.5 V and ends at +0.5 V, the user should set Central D/A Step to 0 V and the 
Ramp Range to +1.0 V.   These two parameters determine the ramp DC offset (0 in this case) 
and its range ( 1 V).   Click implement to update the values.  You should see the changes 
reflected in the graph at the right of the modulation waveform window.  If you then click quit, 
you should also see the changes in the waveform being displayed in the Absorption Spectrum 
window. 

 
If the software is configured to multiplex two or more lasers, then there will be a tabbed 

page for each laser.  Make sure that the modulation values for each laser are acceptable before 
connecting the modulation signals to the lasers. 
 
 In order to measure the spectral transmission, the laser should be turned off for a portion 
of the scan.  This provides a measure of the detector signal in the absence of laser light which is 
required to calculate fractional transmission.  For cw lasers, this is accomplished by applying a 

 
Figure 3.  Modulation waveform menu for pulsed laser case. 
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negative bias to the laser current at the end of each scan in order to drop the laser below 
threshold.  For pulsed lasers, TDLWintel supplies a separate gate waveform that can be used to 
suppress the laser pulses during the shutoff period.  We refer to the negative bias region at the 
end of the modulation waveform as a shutoff pulse.  The shutoff pulse is controlled by two 
parameters.  The Number of points during ramp shutoff determines how long the laser is 
suppressed.  Usually, 10 is a good choice.   The D/A value during ramp shutoff controls the 
voltage level during the shutoff pulse.  Ideally, one should choose a negative value whose 
magnitude is equal to the extent that the laser is being driven above threshold.  Enter parameters 
appropriate to your system.  Click implement.  Verify that the ramp drawn on the right hand side 
is correct.  Then click quit. 
 

2.4 Acquiring Spectra 
 You are now ready to acquire spectra using TDLWintel.   Apply the modulation 
waveform to the laser by removing the test BNC cable and connecting the analog output (DAC0 
OUT) to the frequency modulation input for the laser.  Next, connect the analog input channel 
(ACH0) to the output of the laser detector amplifier.  Turn on the laser.  If the optical system is 
properly aligned a waveform should appear in the Absorption Spectrum window.  Be sure that 
the program is in Current Signal mode (see Section 2.2).  Click on Frame, if necessary, to 

 
Figure 4.  TDLWintel main window showing frequency sweeps and absorption lines for two 
lasers. 



 
9 

center the waveform.  An example spectrum is shown in Figure 4 for an instrument with two 
lasers. 
 
 If you do not see a waveform on the screen, the most likely explanation is that the optical 
system is misaligned or malfunctioning in some other manner.  Monitor the output of the infrared 
detector with an oscilloscope and adjust the optical system until a periodic waveform is 
observed.  The frequency of the waveform should be controlled by TDLWintel and should be 
equal to the Sweep Rate which is reported at the bottom of TDLWintel window under the Status 
frame.  You can identify the Sweep Rate parameter by holding the cursor over the boxes in the 
Status frame.  A label will appear.  The Sweep Rate is reported in the center of the third row.  
Once you observe a periodic waveform with the right frequency on the oscilloscope, you are sure 
to also see it on the computer screen. 
 
 The optical waveform should be similar in shape to the ramp waveform though not 
identical.  Although the modulation ramp is intended to vary the laser frequency only, it is 
usually the case that the amplitude is also modulated.   Also, if you are using the shutoff pulse 
option, the laser signal should sharply diminish at the end of the scan, where the laser current is 
dropped below threshold.  Of course, there may be other frequency dependent features in the 
optical waveform like absorption lines or etalon interference fringes.  If an etalon is available it 
would be quite useful to insert it in the optical path and use it to measure the size of the 
frequency modulation. 
 
 This is a good place to explore the basic data acquisition modes.  The system should 
currently be in Current Signal mode.  In this mode, individual waveforms are averaged together 
and displayed repetitively.  The display looks like an oscilloscope in that new data automatically 
replaces old data.  The time between data updates is controlled under Edit\Timing.  The Data 
Update Time controls the number of waveforms which are acquired before averaging is 
complete.   If each waveform is one millisecond in duration and the update time is set to 1 
second, then one thousand waveforms or sweeps will be averaged together to form one result.  
Usually, this will be accomplished in 1 second, but if it may take longer if the computer is busy 
with another task.  The Display Time controls how often the display is updated.  This is usually 
set equal to the update time for times greater than 1 second.   However, it is sometimes desirable 
to acquire data very rapidly but to display it relatively infrequently.   
 

Both the Data Update Time and the Display Time are probably set to one second at this 
point.  Try changing them both to 0.1 seconds.  Remember to exit the menu window by clicking 
Implement and then Quit.  The display should be updating very rapidly now.  If you block the 
laser beam, the waveform should disappear immediately rather than after one or two seconds.  
This is an excellent setting to use when aligning the optical system since the time response is 
very fast.   

 
Some of the Status parameters should have changed.  For example, the parameter in the 

middle of the left column reports the Accumulation Time – the amount of data which is being 
reported expressed as an amount of time.  This should be approximately 0.1 seconds.  However, 
it may not be exactly 0.1 seconds.  For various reasons, the amount of data collected is usually 
not exactly the amount requested.  Another important Status parameter is the Duty Cycle which 
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is reported in the middle of the third column.  This parameter informs you what fraction of the 
available waveforms are actually being acquired and processed.  The goal is to achieve a Duty 
Cycle between 90 and 100% while acquiring and fitting spectra. 
 

To stop the data acquisition process and examine one spectrum, go to the popup menu 
under the Data Acq. State window and select Display.  The screen should freeze, displaying the 
last spectrum.  To return to Current Signal, go to the popup menu and select Current Signal.  
If you wish to improve the signal to noise ratio in the spectrum, you could choose the Signal 
Average mode.  In this mode, the screen is still updated every 0.1 second, but the old data is not 
discarded.  Instead, each new acquisition is averaged with the earlier acquisitions.  As you watch 
the screen, you will see random noise in the spectrum fade away as the signal becomes clearer 
and clearer.  Random noise should decrease in inverse proportion to the square root of the time 
spent signal averaging.  The Signal Average mode is not used very often but is sometimes used 
when acquiring etalon spectra to define the frequency scale. 
 
2.5 Summary 

You should now be confident that the TDLWintel software is properly installed, that the 
data acquisition hardware is properly configured and that you can acquire spectra using the 
Current Signal and Signal Average modes.  The interpretation of these spectra through 
nonlinear least squares fitting is a more complex task which requires more familiarity with the 
TDLWintel program.  Therefore, before we explain spectral fitting, we will take some time to 
explore the TDLWintel interface and the structure of its operating environment. 

 

3. The TDLWintel Interface 
3.1 Overview 

The TDLWintel window can be divided into three sections.  There is an upper section, a 
middle section and a lower section.   The upper and lower sections contain controls which allow 
the user to manipulate TDLWintel. The middle section is used to display various subwindows 
such as the absorption spectrum, a stripchart of mixing ratios vs. time and a history report.  At 
startup only the absorption spectrum is displayed.  

 
In this chapter, we will identify the interface objects and describe their functions.  The 

pull down menus will only be briefly described here, since they are complex enough to warrant 
their own chapter (see Chapter 4).  

 
 It is helpful to know that most objects in the TDLWintel interface are equipped with 

Tooltip Help.  This means that if you place the cursor on the object, a white box will appear 
describing the object.  Let’s begin with a description of the controls in the upper panel. 
 
3.2  Upper Panel 

 The upper panel contains the pull down menus, the data acquisition mode control, the 
field control, the input channel control, the polynomial order control, the data update LED, the 
port control and the message window.   
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The pull down menus are the most important set of controls.  They are the primary 

method for configuring TDLWintel.  They will be described in great detail in Chapter 4 but only 
briefly here.  Most changes which are made using the pull down menus will be saved in a 
configuration file and remembered.  The File menu has options for saving various file types and 
for loading saved spectra.  The Edit menu allows the user to edit the current operating 
parameters which control the function of the program.  The Command menu allows the user to 
execute various tasks.  These include performing a nonlinear spectral fit, interpreting a 
monochromator reading as a frequency and subtracting two spectra.  Finally, the Window menu 
allows the user to choose which of the available sub-windows are actually displayed in the 
middle panel.  

 
The data acquisition mode control (labeled Display Mode in the figure) has already been 

discussed above.  The current state is reported in the yellow box.  To change the state or mode, 
click on the yellow box and choose from the popup menu.  The basic modes have already been 
discussed: Display, Current Signal and Signal Average.  These basic modes acquire and 
display spectra but do not automatically analyze it.  The advanced modes acquire data and 
analyze it simultaneously.   

 
Thus, in Stream mode, data is acquired and analyzed in a continuous stream and the 

concentrations derived from the fit are also continuously reported.  The reporting options include 
a graphical display, writing the values to disk, sending the values to the serial port and producing 
analog output voltages proportional to the concentrations.  There is no limit on the length of a 
data stream.  Data can be acquired for a few seconds or for years.  Depending on the complexity 
of the fitting and the speed of the computer, data can be acquired in Stream mode with a time 
resolution of approximately 0.02 to 0.2 seconds. 

 
If greater time resolution is required, then Burst mode should be selected.  In Burst 

mode data acquisition and analysis are not performed simultaneously.  Instead, data is acquired 
in a buffer with the best possible time resolution and is analyzed afterwards.   Since individual 
spectra can be acquired in 10 to 30 microseconds, the time resolution can be this good.  This 
allows monitoring of fast chemical processes directly.   Data can only be acquired for a few 
seconds in Burst mode.  Then the program stops acquiring data, analyzes the data in the buffer, 
and transmits the results. 

 
The Playback mode provides a powerful tool for reanalyzing previously acquired 

spectra.  This can be done spectrum by spectrum or using batch processing.  The Playback mode 

 
Figure 5.  Upper panel of TDLWintel interface. 
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can also be used for redisplaying spectra acquired during an event and playing them back at a 
later time.  This produces a spectroscopic movie which can be displayed during presentations or 
at meetings.   

 
To successfully use the advanced modes requires more than simply selecting them from 

the data acquisition state control.  The program needs to know how to fit the data, the desired 
time resolution and how to trigger the start of data acquisition (in Burst mode).  There are 
additional optional parameters as well.  All of these parameters are displayed and set in the Edit 
menu and will be fully explained in that section of the manual. 

 
Directly to the right of the data acquisition mode control is the Field control.  To change 

fields simply click on the yellow box.  Right clicks increase the field number, left clicks decrease 
it.  Fields allow the program to keep track of up to four sets of operating parameters and spectra. 
Fields are used in two distinct ways.  They can be used independently or cooperatively.  
Typically, the fields are used independently during setup and cooperatively during data 
acquisition.   

 
When used independently, fields are parallel independent work spaces.  When you switch 

between fields, TDLWintel loads a new set of menu parameters specific to that field and a new 
spectrum which was last acquired with that field.  This is convenient if you want to switch 
between two sets of operating conditions without editing the operating parameters.  It also allows 
two spectra to be loaded simultaneously for the purpose of subtracting them or dividing them.   

 
Fields can also be used cooperatively.  The fields become cooperative when any data 

acquisition method that requires multiple fields is activated.  For example, there is an automatic 
background suppression method which acquires background spectra in one field (Field 3), signal 
spectra in another field (Field 1) and automatically divides them to improve the signal to noise 
ratio of the signal spectra.  When any cooperative method is active (Automatic Background 
which used Field 3, Automatic Calibration which uses Field 1, Power Normalization which used 
Field 2 or Frequency Lock which uses Field 4), the menu parameters and toggle controls in Field 
1 control the program’s operation no matter which field is being displayed.  In other words, 
changing fields in cooperative mode allows you to see what is happening in the various fields but 
it does not change the program’s operation.  Also, the menu parameters and toggle settings in 
Fields 2, 3 and 4 cannot be changed while the fields are cooperative.  If you want to change 
parameters in these fields, you must return to Field 1 and turn off the cooperative methods first. 
 

To the right of the Field control is the A/D input control.  Clicking on the yellow box 
changes the selected A/D input channel.  To the right of the A/D input control is the polynomial 
order (Poly) control.  This controls the order of the polynomial which is used to model the 
baseline in the nonlinear spectral fits.  Third order is usually a good choice.  Excessively high 
polynomial orders are seldom necessary and always risky.  To the right of the polynomial order 
control is the Data update display.  Whenever enough spectra have been accumulated to average 
them and display or fit them, the red circle advances one step in the clockwise direction.  Hence, 
this display gives a visual indication of the data processing rate.  Finally, to the right of this 
display is the serial (RS232) Port control.  When the serial port is open, the circle is green.  It is 
white when the port is closed.  Clicking on the label toggles the state of the port. 
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Underneath these controls is a long white bar – the History Bar.  TDLWintel writes 

messages in this bar.  These include simple declarations of program activities (spectrum saved, 
reference spectrum checked, etc…) as well as warnings and error messages.  The complete list of 
messages, including user created comments is stored.  Although these can be viewed using the 
History Bar, it is more convenient to view the complete list using the History window which 
can be accessed under the Window menu tab. 
 

3.3  Lower Panel 
  The lower panel contains the Toggle Controls control, the Status control, the View 
Burst Spectra control, the Playback Frame by Frame control, the Laser temperature and 
current (or voltage) control and the large numeric display.  We will discuss each of these in turn 
beginning with the Toggle Controls. 

 
 The Toggle Controls are a collection of command buttons which can be clicked to adjust 
Methods.  Many of the buttons are true toggles – they are either on or off.  When a method is on, 
the button is colored blue, when it is off, the button is gray.  Some of these features are not true 
toggles since they cycle through several states.  The parameters are usually field specific, so 
when you change fields the Toggle Controls will be modified.  None of these operating 
parameters are saved in the configuration file since the desired state is likely to vary frequently 
within a session.  For most of the toggles buttons, left clicking will turn the method on and off 
and right clicking will open a menu to configure the method.  Let’s discuss each of the toggle 
buttons in turn beginning in the top row. 
 

1) The wd button toggles the write to disk method.  When it is on and the program is in 
stream mode or burst mode, the molecular concentrations which are returned from the 
spectral fits are written to a file with the extension “.str”.  A time stamp is also written 
for each measurement.  Other information may also be written to disk at the users 
discretion (see section 6.2 on Data Output). 

2) The gl button toggles the guess last method.  When selected, the results of the latest 
nonlinear least squares fit are used to provide the initial guesses for the next fit.  This 
option only works in stream or burst mode.  It tends to give faster time response since 
the fits converge faster.  However, there is increased risk of the fit failing to converge 
if conditions change too rapidly. 

3) The f1 button controls the binomial filter method.  The spectrum can be filtered using 
a binomial filter to reduce noise.  The order of the filter is varied by clicking on this 
button.  The lowest order (order =1) is equivalent to no filtering at all and is the 
recommended setting. 

4) The ASS button toggles the automatic spectral save method.  When selected, spectra 

 

 
Figure 6.  TDLWintel lower panel. 
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that are automatically saved to disk as they are acquired in a special binary file format 
with extension “.spb”.   

5) The pn button toggles the pulse normalization method.  This is used to normalize 
pulse to pulse amplitude variation when using pulsed lasers.  It is sometimes also 
used to normalize continuous wave lasers.  Before turning it on, several parameters 
must be determined and set.  See the description of the Power Normalization 
Method the Chapter 7 for more information. 

6) The RS button toggles the RS232 output method.  When selected, species 
concentrations determined in stream mode or burst mode are written to the serial port.  
This is analogous to the wd option except that the concentrations and time stamps are 
sent to the serial port to be logged by another computer. 

7) The CAL button toggles the automatic calibration method.  With this option active, 
the program will periodically acquire a calibration spectrum by adding calibration gas 
to the sample cell.  The result of the calibrations is reported to a calibration output 
file.  For further information see Section 8.3. 

8) The flk4 button toggles the “frequency lock in field 4” method. With this method the 
frequency of the laser is monitored (either occasionally or continuously). If 
significant frequency drift is detected, it is corrected by modifying the laser frequency 
– usually by temperature tuning the laser. For further information see Section 6.3. 

9) The abg button toggles the “automatic background” method.  With this active, the 
program will periodically acquire a background spectrum with no sample present in 
optical path and will store this background spectrum in Field 3.  Future signal spectra 
are normalized by this background spectrum in order to remove baseline curvature, 
interference fringes and possibly background gas absorption.  For a complete 
description see Section 8.2. 

10) The ebg button toggles the manual background subtraction method.  This option is 
used to subtract a weak but constant waveform from the signal spectrum. A good 
example would be structured electronic pickup, synchronous with the modulation 
waveform.  The interfering waveform is acquired once and saved.  This waveform is 
subtracted from all subsequent signal spectra. 

11) The PL button toggles the pressure lock method for systems that have software 
controlled inlet valves.  When this is activated the program will adjust the inlet 
valve(s) to maintain the desired pressure in the optical absorption cell(s).  This is 
discussed in detail in an appendix. 

12) The ds button chooses between the three spectral display methods: display signal 
(ds), display transmission (dt) and display residuals (dr).  The normal display is 
display signal.  If the data has been least squares fit, then the fit has returned an 
estimate of the baseline under the spectral peaks and an estimate of the spectrum 
itself.  This allows the program to calculate a transmission spectrum (dt) and a 
residual spectrum (dr). 

13) The AR button toggles the auto range method.  When this option is activated the 
spectral window will automatically rescale itself when the signal becomes too small 
or too large.  This is useful when aligning the optical system and trying to obtain the 
largest possible signal.  If the AR button is clicked a second time, it will switch to AF 
or automatic follow.  In this case, the window sized is constant, but it moves up and 
down to stay centered on the waveform. 
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14) The AS button toggles the automatic startup method.  If you exit the program with 
this option activated, then the next time that the program is launched it will 
automatically start taking data.  Specifically, it will tune the laser frequency to the 
correct value, enter stream mode and begin saving data without operator intervention.  
The details of this method are discussed in an appendix. 

 
This is a good place to clarify the differences between Methods and Modes.   Modes are 

the fundamental data acquisition states.  Modes cannot be combined.  We cannot conceive of 
being in Current Signal at the same time as we are in Signal Average.  Modes always make sense 
within a single field, they do not require multiple fields. 
 
 In contrast, methods do not make sense by themselves – they must be applied to a 
specific mode.  Methods are more like procedures.  Examples of methods are Frequency Lock 
and Guess Last.  Methods can generally be applied to more than one data acquisition mode.  
Often, though not always, methods are multi-field or multi-input in nature.  For example, 
Frequency Lock automatically employs Field 4 to evaluate the reference spectrum.  And Pulse 
Normalization can monitor two detectors in order to normalize the signal. Multiple methods can 
be active simultaneously.  For example, Frequency Lock, Guess Last and Auto Background can 
all be active at the same time.  There are restrictions however.  Not all methods can be freely 
combined and the way that they are allowed to combine may depend on the data acquisition 
mode. 
 

The Status control displays several important experimental variables.  In the first row, 
the Signal Range, the Sample Pressure,  and the Sample Temperature are displayed.  The 
range is a measure of the amount of light on the detector.  The temperature (T) and pressure (P) 
are the values used to do the spectral fit to the acquired spectra.  They can either be set to fixed 
values or measured continuously.  See the discussion under P,T,L in the Edit menu for details. 

 
The second row of the Status control reports the Accumulation Time, the Repetition 

Rate and the Duty Cycle for the last data sample.  The Accumulation Time is the amount of 
data which is being reported expressed as an amount of time.  This should be approximately to 
the Data Update Time which is the requested time resolution.  However, it may not be an exact 
match and the Accumulation Time may not be the same for each acquisition.  For various 
reasons, the amount of data collected is usually not exactly the amount requested.  The Duty 
Cycle parameter reports the fraction of the available waveforms that are actually being acquired 
and processed.  The goal is to achieve a Duty Cycle between 90 and 100% while acquiring and 
fitting spectra.  The Repetition Rate is the frequency for the arrival of new spectra.  In other 
words, its inverse is the time between new samples.  The inverse of the Repetition Rate (time 
between samples) should be equal to the Accumulation Time (time in sample) divided by the 
Duty Cycle.  For unity duty cycle, the time between samples is the accumulation time. 

 
The third row of the Status control reports the Clock Rate and the Sweep Rate.  The 

Clock Rate is the rate of individual digital to analog conversions.  The Sweep Rate is the 
inverse of the modulation waveform period.  The Sweep Rate is equal to the Clock Rate divided 
by the number of points in the modulation waveform.   Typical values for these parameters are 
500 kHz and 5 kHz (for 100 points). 
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The View Burst Spectra control is not visible except in Burst mode.  This control 

appears after a burst acquisition is finished and is used to navigate through the collection of 
spectra which have been acquired.  This control is described in detail in the chapter on Burst 
mode. 

The Playback Frame by Frame control is not visible except when Playback mode is 
executed and the frame by frame option is selected.  This control is discussed elsewhere. 

 
The Laser frequency control is located to the right of the Status control.  It takes on 

various forms depending on the type of laser that is being controlled.  The example shown in the 
figure is for a pulsed QC laser.  This control allows the user to adjust either the laser voltage or 
the laser temperature for either laser.  The control contains two command buttons: one labeled 
“+” and one labeled “-“.  These buttons increase or decrease the selected laser property - voltage 
or temperature in this case.  The selected property is displayed at the top of the control.  Clicking 
on this label steps through the list of available properties.  For a single pulsed laser system two 
properties are available: voltage and temperature.  For a dual pulsed laser system four properties 
are available: the voltage and temperature for each laser.  The properties can be adjusted in 
various step sizes by clicking on the box that shows the current step size.  The Laser frequency 
control also displays the measured values of the laser temperature and voltage (or current, if 
available).  

 
The final element of the lower panel is the large numeric display which is located to the 

far right.  This can be used to display any of the values in the Status control for more convenient 
viewing.  Simply click on the Status control label that you want to enlarge. 
 

3.4  Middle Panel 
  The middle panel is a display area which can contain several different sub-windows.  At 
startup only the Absorption Spectrum is displayed in the middle panel (see Figure 4).  The 
Absorption Spectrum is a plot of laser intensity versus channel number.  The channel number is 
simply the index for the discrete data points which make up the frequency scan.  Increasing 
channel number corresponds to increasing laser frequency but the relationship is not perfectly 
linear.   
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 A set of command buttons are provided for manipulating the portion of the spectrum 
being viewed and its magnification.  There are three buttons for the horizontal axis and three for 
the vertical axis.  The four zoom in and zoom out buttons are self-explanatory.  The third button 
on the vertical axis is labeled Frame.  Clicking this button will frame the spectrum vertically.  
The third horizontal button is labeled Full.  Clicking this button will frame the spectrum 
horizontally – that is the full spectrum will be displayed.   
 
 The mouse can also be used to manipulate the portion of the spectrum being viewed.  If 
the left mouse button is clicked and dragged, a box will be drawn on the screen.  When the 
button is released the horizontal and vertical axes will be redefined to display the area defined by 
the box.  If this same operation is performed with a right click, the box will be drawn and can be 
used to measure peak heights and widths, but when button is released, the axes will not be 

rescaled. 
 
 The mouse can also be used to place fit markers on the absorption spectrum.  Fit markers 
are used to define the location and type of nonlinear least squares fit.  The location for the fit 

 

 
Figure 7.  Stripchart window and status report window. 
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marker is chosen with a left mouse click.  The type of fit marker is chosen from a popup menu 
that appears with a right mouse click.  A complete description of this procedure is given in the 
chapter on “Setting Up a Fit.” 
 
 The second type of sub-window which can be displayed (see Figure 7) in the center panel 
is the Concentration Stripchart window which plots molecular mixing ratios versus time.  In 
some ways this window behaves similarly to the Absorption Spectrum window.  It has the 
same six buttons for zooming in and out, horizontally and vertically.  It also allows you to zoom 
in with a left mouse drag or measure areas with a right mouse drag.  The stripchart window also 
has some unique features.  There is a button labeled “Now” that automatically zooms into the 
data that is currently being acquired.  There is a button labeled “Plot Scaled MR’s” that will plot 
the mixing ratios for multiple species on a common normalized scale.  Also the stripchart has 
eight labels at the bottom of the window which report the average mixing ratios of up to sixteen 
species (8 at a time) as well as the root mean square variation in these averages.  When multiple 
species are being acquired, it is sometimes difficult to view all of the graphs at the same time.  
For this reason, it is possible to suppress the plotting of any species by left clicking on its label.  
Also, the color for each displayed plot can be chosen by right clicking on the appropriate label. 
 

There are three other windows which can be displayed in the central panel – the Fit 
Report window, the Status Report window and the History window.  The fit report provides 
information about the details of the nonlinear least squares fits as they are performed.  This 
information includes the number of iterations required to converge, the duration of the fit and the 
values returned by the fit.  The status report, shown in Figure 7, gives a quick look at many 
important parameters.  It provides the range of each laser in each field, the gain settings and AD 
settings in each field, and the values of pressure, temperature and path length used in each field.  
It also gives information about the state and scheduling of all 8 valves and switches which may 
be controlled by TDLWintel.  Finally, it provides the voltage readings for several of the slow 
analog inputs from the slow analog card.   The first two inputs are sample pressure and sample 
temperature.  The history window is a detailed summary of all messages which have appeared in 
the History Bar and their associated time stamps. 
 

4. Using the Pull Down Menus 
4.1 Overview 
The pull down menus are the most important set of interface controls.  We devote a 

chapter to them because they are the primary method for configuring TDLWintel.   Most changes 
which are made using the pull down menus will be saved in a configuration file and 
remembered.  The File menu has options for saving various file types and for loading saved 
spectra.  The Edit menu allows the user to edit the current operating parameters which control 
the function of the program.  The Command menu allows the user to execute various tasks.  
These include tasks like performing a nonlinear spectral fit, operating valves and switches, 
measuring the laser tuning rate and subtracting two spectra.  Finally, the Window menu allows 
the user to choose which of the available sub-windows are actually displayed in the middle 
panel.  We will discuss each of these menus in turn. 
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4.2 The File Menu 
 The File menu deals primarily with 
saving and loading files.  It is displayed in 
Figure 8.    The first three entries are 
concerned with configuration files (*.con).  
When TDLWintel starts up, it always 
loads the tdl.con file that it finds in its 
startup folder.  This file stores all hardware 
and menu parameters from the previous 
session.  The first two menu items allow 
you to update the tdl.con file or to save a 
copy of the current tdl.con file with a 
different name.  The tdl.con configuration 
file is saved automatically at the close of 
each session and whenever menu 
parameters are edited.  However, it is not 
saved after each new spectrum is acquired 
or after each modification of the fit 
markers.  Therefore, it is sometimes useful 
for the user to manually save the 
configuration file.  It can also be useful to 
save the current configuration under a 
different name in order to save it for future use.  The section option allows for this and the copy 
is stored in the Configs folder.  TDLWintel also automatically saves configuration files in this 
folder to create an archive of past operating conditions.  The third item in this section of the 
menu allows you to load a previously saved configuration file.  This will restart the program 
using the parameters in the specified configuration file.   

 
The configuration file contains a header with information that does not change often and 

cannot be accessed while the program is running.  The header information must be edited 
directly in the “tdl.con” file if it needs to be changed.  The header information includes things 
like the title bar for the program, the number of lasers controlled, the indexes for addressing the 
data acquisition boards and the serial port specifications.  This is discussed in detail in the 
chapter on file structures. 
 

The second section of the File menu allows you to load and save basic spectral files 
(*.spe).   Spectral files are files which contain previously recorded absorption spectra.  However, 
they contain much more than just the spectrum.  Each spectral file contains the menu parameters 
which were in effect when it was saved.  Each spectral file also contains the result of any fits 
which were performed upon it and the fit markers which were used to define the fit.  See the 
chapter on file structures for a more detailed discussion of spectral files.  When a spectrum is 
loaded, the menu parameters saved with the spectrum replace those that are currently being used.  
This can be used to revert to a previous set of experimental conditions.  

 
The third section of the File menu concerns binary spectral archives (*.spb).   These SPB 

files are created by the program whenever it automatically saves spectra.  Rather than creating 

 
Figure 8.  Options under the File menu. 
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one SPE file for each data point, the program creates one binary archive (for each hour of the 
day) and packs all spectra (of a given type) into that binary archive.  This greatly reduces storage 
requirements and greatly speeds up data transfer and data reanalysis.   

 
The first SPB related menu item is Browse Binary Spectrum.  This feature will open one 

or more binary archives and allow you to see the spectra.  Simply select the folder that contains 
the SPB files of interest.  They are loaded into Field 1 of TDLWintel and refit.  A control 
appears in the bottom panel of the interface that allows you to step from spectrum to spectrum or 
from archive to archive or to even just enter a date and time to find the associated spectrum.  
This option actually puts the program in Playback mode and executes a “frame by frame” 
playback while selecting reasonable playback parameters.  The same thing can be accomplished 
more flexibly by editing the Playback parameters directly under the edit menu.  See below for a 
full discussion of the Playback mode and its configuration options. 

 
The other SPB options support various manipulations of the SPB files.  The first of these 

options allows the user to specify a set of time stamps which the program then uses to find 
individual spectra with selected SBP archives.  This collection of spectra are then co-averaged.  
The second and third options allow the conversion of an SPB archive file to a folder of SPE files 
or vice versa. 

 
TDLWintel also creates stream files (*.str) and stream conditions files (*.stc).  The 

stream files contain the results of the spectral analysis, that is, the mixing ratios derived from 
each spectrum and the associated time stamp.  Each line of the stream file gives the mixing ratios 
at one moment in time.  The stream conditions file has a similar structure.  It reports various 
housekeeping variables as a function of time.  These STR and STC files are saved in the default 
data folder.  This default data folder can be specified by the user under the File menu.  If the user 
does not specify a folder, then a folder named “Data” is created and used.   

 
Another option under the File menu is Change Transient Data Drive which allows the 

user to select a local or remote drive to receive concentration data.  The transient data option 
allows data to be shared easily with other 
networked computers.  This is explained 
further under Section 6.2 on Data Output. 

 
Finally, the program Exit 

command is also located on this pull down 
menu. 
 

4.3 The Edit Menu 
 The Edit menu (see Figure 9)  
provides the primary method for editing 
most of the important operational 
parameters.  The parameters accessed 
through the Edit menu are saved both in 
spectral files and in the configuration file 
so that they do not need to be re-  

Figure 9.  Options under the Edit menu. 
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established with every new session.  Most menu items are field specific – that is a different value 
of the parameter can exist for each of the four data fields and changing the parameter in one field 
does not affect the corresponding parameter in the other fields.  However, there are a significant 
number of menu items which are field independent.  If these parameters are changed in one field, 
they are changed in all fields.  There are labels on the edit pages which clearly state which 
parameters are field dependent and which are independent. 
 

The first section of the Edit menu provides access to parameters which control the 
mechanics of the basic data acquisition process: the creation of the modulation waveform and the 
timing settings for driving the laser, monitoring the infrared detector and averaging the data.  The 
first Timing entry is the Data Update Time which is the length of time that the program signal 
averages spectra before reporting a new result.  If spectral fits are being performed, the data 
update time is the time resolution for molecular concentrations.  The Display Time is the time 
between screen updates of the absorption spectrum and the strip chart.  It must be greater than or 
equal to the data update time.   The Flow Cell Response Time is relevant if a flowing absorption 
cell is in use.  If so, the flow cell response time is the time required for the cell to be completely 
flushed.  Finally, the A/D Clock Rate is the rate of individual A/D conversions.  A good choice 
for this parameter is usually 1 MHz but the optimal choice will depend on laser characteristics.  
The final parameter in this sub-menu is the time delay between the laser trigger and light pulse 
detection.  This parameter is only used with pulsed lasers and can only be adjusted in increments 
of 50 ns. 
 

The Modulation Waveform window is more complex (see Figure 3).  It’s purpose is to 
define the basic modulation waveform which is output by the analog output (DAC).  For a single 
laser system, this waveform is available on channel 0 (DAC0 Out).  The adjustable waveform 
parameters are on the left of the form and a graph of the selected waveform or waveforms is on 
the right.  The Y axis of the graph ranges from –10V to +10V (for cw lasers) or from 0 to +10V 
for pulsed lasers, corresponding to the available output range of the DAC.  The Y axis will also 
have current labels, showing the range of laser current that results from the minimum and 
maximum DAC voltages.  It is the user’s responsibility to be sure that the selected 
modulation waveform does not exceed the acceptable range of input voltage for the laser. 

 
It is safest to begin with a small amplitude ramp centered at 0 V and to increase the 

modulation gradually.  There are several parameters which combine to specify the size and shape 
of the waveform.  The Number of Points is the number of data points acquired from the detector 
during a single frequency scan of this laser.  The slope of this ramp for this laser is determined 
by the Ramp Range which is the magnitude of the voltage sweep provided by the digital to 
analog converter (DAC) during a complete scan of this laser.  The Central D/A Value is the 
absolute value of the analog output at the center of the scan.   

 
If the software is configured to multiplex two or more lasers, then there will be a tabbed 

page for each laser. The three waveform parameters (number of points, ramp range and central 
value) are repeated on each laser tab if there are multiple lasers being controlled by the software.  
For a single laser system, there is a single graph displayed and the waveform is output on DAC0 
Out.  For a dual laser system, there are two graphs displayed.  The waveform for the first laser 
(blue trace) is ouput on DAC0 and that for the second laser (green trace) is output on DAC1.  For 
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a four laser system (pulsed QC lasers only), there are again two graphs shown.  In this case the 
waveform output to DAC0 (blue trace) should be connected to the first and third lasers and the 
waveform produced on DAC1 (green trace) should be directed to the second and fourth lasers. 

 
At the bottom of the window are two general parameters that do not vary with laser 

number.  The Number of Points During Ramp Shutoff is the number of points at the end of the 
scan during which the analog output is set to a constant value.  For CW lasers this value should 
be low enough to suppress lasing and to provide a measurement of zero laser light intensity.  The 
voltage level during this suppression is set by the D/A Value During Ramp Shutoff.  
   
 The second and third sections of this menu allow you to configure features that are 
discussed in detail later in the manual.  These include: 1) the Burst Mode entry which allows 
editing of the parameters which control how data is acquired with high time resolution,  2) the 
Playback Mode entry which allows editing of the menu items controlling the reanalysis or 
redisplay of archived spectra and 3) the Master/Slave method which allows two instances of 
TDLWintel to run from a single clock so that the two instances are phase locked. 
 
 The final section of the Edit menu concerns the items required to perform and quantify 
nonlinear least squares fits.  The Fitting Params by Species entry is the most important option.  
It provides access to the individual fit parameters, their initial guesses and options to fix or float 
them.  It also specifies the spectroscopic constants used to fit the data.  A detailed discussion of 
these parameters will be deferred to the next chapter (“Setting Up a Fit”).   
 

The Tuning Rate Params are accessed under the next entry.   This entry is used to 
display and to modify the existing tuning rate(s).  The tuning rate for each laser is generally 
determined using the Get Tune Rate From Etalon command under the Command menu.  The 
resulting tuning rate can be observed with the “Tuning Rate Params” menus item.  It can also be 
slightly modified using the stretch and distort buttons.  This is not generally recommended but is 
occasionally useful.  Finally, the free spectral range parameter should be set to the appropriate 
value for the etalon that is used to determine the tuning rate.  Please note that the FSR can vary 
between lasers because it may be a function of frequency. 
 
 The General Fit Params consist of five parameters which are not species specific.  These 
include the Maximum Number of Iterations in the fit and the Convergence Criterion for the 
fit.  Typical values for the quantities are 10 and 0.001 respectively and they should not require 
frequent modification.  The Signal Threshold for Fitting defines a lower limit to the Signal 
Range, below which spectral fits will not be attempted.  This prevents the program from fitting 
to noise.  The Polynomial Order is the same quantity which is displayed in the upper panel of 
the TDLWintel window.  This defines the order of the polynomial function used to simulate the 
spectral baseline.  Usually, the best choice is second or third order.  The Maximum DC Level 
for Fitting is intended for use with DC coupled liquid nitrogen cooled detectors.  The output 
voltage of these detectors rises when the detector warms up which can be used to stop the data 
fitting process.  Enter a value that is significantly larger than the detector’s DC output voltage 
when cold.  To disable this feature, simply set the parameter to a large value – like 10,000 mV.  
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 The Laser Characteristics 
menu is shown in Figure 10.  There 
are tabs for each laser that allow 
several parameters related to laser line 
width to be adjusted for each laser.  
The first of these parameters is the 
Laser Line Halfwidth.   In many 
applications the laser’s frequency 
width is not negligible compared to 
the spectral width.  If this is the case, 
you should specify the observed laser 
width here and the fitting routines will 
include this extra broadening in the 
spectral simulations as an additional 
Gaussian broadening term.  There is a 
checkbox that causes the program to 
automatically determine the laser 
linewidth while fitting the data.  This 
should only be attempted while 
monitoring a spectrum with good 

signal to noise ratio.  We do not recommend using this option while taking data.  It should be 
used once to determine the laser line width and should then be disabled.  The second item in this 
menu should be used with care.  This item allows the user to account for variation in the laser 
linewidth as a function of laser frequency; that is, as a function of location in the scan.   There 
are two options available under the Instrumental Linewidth Options frame.  The first option is 
the normal setting.  The second option should only be necessary for optically thick lines (OD > 
0.2) and relatively broad (i.e., pulsed) lasers. 
 

The Average Laser Power parameter is not generally used unless it is not possible to 
turn off the laser at the end of each scan.   Suppressing lasing is a much better method of 
defining the optical intensity.  If the laser power parameter must be used, please be aware that 
the value entered is interpreted as the average value of the power (averaged over all lasers) - but 
ignoring the channels at the end of the scan during the ramp shutoff.  It is sometimes useful to 
use this feature to measure the “dark noise” of the spectrometer.  This is discussed later in the 
manual. 

 
The Detector Characteristics menu option allows the user to activate a normalization 

procedure that will attempt to correct the detector output if its response is non-linear.  For mild 
nonlinearity, selecting this option can give improved absolute accuracy and reduced variation of 
retrieved mixing ratio with variation in optical power.  This feature should be used with care 
since there is no easy way to convert spectra acquired with this option to their original 
uncorrected form.  

   
 The final set of fitting parameters (see Figure 11) is designated P,T,L for pressure, 
temperature and length (optical path length).  The pressure and temperature have the option of 
either being specified by the menu values (fixed) or determined by the secondary analog board 

 
Figure 10.  Laser Characteristics menu options. 
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(measured).  If they are measured, there is an option to average the measurement results with a 
time constant defined in the “Tau” box.  There is also an option to turn on extra electronic signal 
averaging which results in more precise temperature and pressure measurements.  This option 
will noticeably slow the maximum fitting rate.  
 
 Other parameters in this menu include the Ambient Path Length and temperature which 
are used when fitting spectral absorption features that occur outside of the low pressure multi-
pass cell.  There is also a pressure sensor offset parameter that allows you to correct for drift in 
the zero offset of the pressure sensor. 

 
 
Figure 11.  Menu options for pressure, temperature and path length. 
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4.5 The Command Menu 

 The command menu (see Figure 
12) allows the user to execute many tasks.  
Depending on your instrument’s hardware 
configuration, different options will be 
presented under this menu.  We will 
describe some of the more important 
options in this section. 
 
 Adjust Laser Settings invokes a 
window for detailed control of the 
temperature and voltage (or current for 
CW lasers) settings for all lasers. This 
control allows you to set the values of 
these parameters as well as to set software 
limits on their range.  This window also 
displays the current value of all monitored 
parameters.   

 
The Operate Valves and Switches 

command is used to manually control 
various solenoid valves or solenoid 
switches that may exist.  The software 
allows up to 8 of these devices if the 
proper hardware is available.  Typical 
applications are to control the flow of 
background gas or calibration gas, to move 
an etalon into the optical beam path or to 
select a beam path to send to the detector.  
This option requires that the appropriate hardware is installed in the instrument.  A related 
command is Schedule Valves and Switches which allows the user to set a schedule for the 
automatic opening and closing of the same 8 solenoid driven devices. 

  
The Control Inlet Valves command applies to systems that have an Aerodyne pressure 

control system installed to control the pressure in the sampling cell.  This menu configures the 
parameters used in the software control loop.  This menu is discussed in more detail later in this 
manual. 

  
The next set of commands is related to nonlinear least squares fitting.  Do A Spectral Fit 

executes a single nonlinear least squares spectral fit.  Before executing a fit, fit markers must be 
defined and several menu parameters must be properly set.  See the next chapter for a detailed 
discussion of setting up spectral fits.  Clear Fits removes the preceding spectral fit from the 
screen and from memory.  Get Tune Rate From Etalon executes a different sort of fit. It fits the 
minima and/or maxima in an etalon trace to determine the tuning rate of the laser.  To use this 
function, insert an etalon in the optical system and acquire a high signal to noise ratio spectrum 

 

 
Figure 12. Options under the Command menu.  
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of the etalon fringe pattern.  With the appropriate fit markers on the screen, this option will use 
the interference pattern to determine the tuning rate of the laser as a function of frequency.  A 
detailed description of this procedure is given in the next chapter.  The Convolution Calibration 
creates a set of polynomial coefficients that can be used to correct optically thick spectra for 
fitting errors introduced by the finite laser line width.  The detector saturation entries allow you 
to measure and correct for detector non-linearity effects.  These tools can be used to set the 
saturation parameters in the Edit/Detector Characteristics menu item. 

 
The Kopy Konditions to Klipboard command is a very useful tool.  It creates a brief 

summary of current operating conditions and puts it on the computer’s clipboard.  This summary 
can be quickly pasted into your electronic notebook.  The command to resynch the ms timer 
defines the current time in the Windows millisecond timer to be equal to the current system time.  
The program uses the Windows millisecond timer to time events precisely, but this timer is not 
referenced to any absolute time and may need to be synchronized to an external time.  Finally, 
the resynch Master/Slave command phase locks two instance of TDLWintel which are running 
in parallel. 

 
The bottom section of 

the menu has three commands 
which allow information to be 
exchanged between fields.  
Field dependent information 
includes the menu parameters, 
the fit markers and the spectral 
data.  The Duplicate command 
copies the values for all of this 
data from the current field into 
all other fields.  The Transfer 
command (see Figure 13) is a 
more selective version of the 
Duplicate command in two 
ways.  First, it transfers data from one field to a second field and requires the user to choose the 
fields.  Second, the data which is transferred can be specified as either the menu parameters, the 
fit markers, the spectrum, the tuning rates, the ramp (modulation waveform), the fit parameters 
or all of the above.  The last command is the Ratio, Subtract, Add command which allows the 
user to perform simple arithmetic with spectra which are specified by the field that they are 
displayed in. 

 
4.6 The Window Menu 

 The window menu is relatively simple.  Options are provided to display or to hide the 
several possible sub-windows: the Spectrum, the Mixing Ratio vs. Time, the Fit Report, the 
Status Report and the History.  In addition, an option to Auto Arrange these windows is given.  
Auto Arrange is recommended and is the default choice.  It automatically arranges the selected 
sub-windows side by side with no overlap and with equal sizes.  If you wish to arrange the 
windows in a different fashion, then deselect Auto Arrange and adjust the windows to your 
taste.  

 
Figure 13.  Menus for transferring parameters between Fields. 
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5. Setting Up a Fit 
5.1 Overview 
One of the most powerful TDLWintel features is its ability to calculate absolute mixing 

ratios for molecular species in real time.  This feature relies on TDLWintel’s ability to interpret 
spectra by fitting them to a model spectrum using nonlinear least squares fitting.  The result 
returned by the fit includes one or more mixing ratios or concentrations for the molecules which 
are responsible for the spectrum. The nonlinear least squares fitting routine is crucial for absolute 
absorption measurements and for lineshape studies.  The fitting routine uses the Levenberg-
Marquardt approach.  The laser power spectrum is represented as a slowly varying polynomial of 
adjustable order; typically a quadratic or cubic polynomial is used.  The absorption lineshapes 
are fit to Voigt profiles.  The program is capable of simultaneously fitting contributions from up 
to five molecules.  Separate fits can be done sequentially in order to fit up to sixteen molecules 
within a single spectrum. In addition, the spectrum from each molecule can be composed of as 
many as 1000 individual spectral lines.  The contribution of each molecule to the spectrum is 
simultaneously fit together with the laser polynomial baseline. 
 
 It is a significant complication that the frequency of the laser does not vary perfectly 
linearly with the applied voltage ramp.  Therefore we must measure the tuning rate.  It can be 
determined by using TDLWintel’s tuning rate utility which automatically determines the tuning 
rate by analyzing a frequency scan acquired with an etalon inserted in the beam path.  We 
typically use an etalon with a free spectral range of 0.05 wavenumbers.  The tuning rate is 
determined using a numerical method based on cubic spline interpolation.  For some instruments 
the etalon can be automatically inserted into the optical path by toggling a solenoid. 
 
 There are three parts to defining a spectral fit: 1) Fit markers must be placed on the 
spectrum, 2) The species specific fitting parameters must be defined, and 3) The laser tuning rate 
must be defined.  We will cover each of these tasks in detail beginning with the first task.  We 
presume that the General Fit Params, Laser Characteristics and P,T,L menu items have been 
set to appropriate values as described in the previous chapter. 
 

5.2 The fit markers 
Fit markers are placed on the spectrum at particular locations to define the types of fits 

desired and the locations for those fits. Each fit must have a marker which defines the start of the 
fit and a marker which defines its end.  There are also markers to define the regions between 
spectral peaks (baseline regions), the positions of peaks and the region where the laser is turned 
off.  We will cover each of these in turn but first let’s discuss how to place a fit marker on the 
spectrum. 
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This is accomplished 
with the popup menu that 
appears when you click the right 
mouse button in the Absorption 
Spectrum window.  The popup 
menu presents a list of all 
possible fit markers and you 
simply choose the marker that 
you want.  It is placed on the 
spectrum at the channel number 
where the blue “+” sign sits.  
The “+” can be moved in two 
ways.  First, the arrow keys 
move it left and right by one 
channel at a time.  The second 
approach is to use a left mouse 
click at the desired position for 
the marker.   The fastest way to 
enter several fit markers is as 
follows.  Left click at the 
position for the first marker.  
The plus sign will move there.  
Then right click and select the 
appropriate marker.  Now, left 
click at the position for the second marker.  Two things will happen.  The plus sign will move 
there as usual.  In addition, the popup menu will automatically appear without a right click.  This 
is because the program is guessing that you may want to apply more fit markers.  So, simply 
choose the second marker.  Then click at the location for the third marker and again the popup 
menu will automatically appear with your list of options.  When you are through, left click one 
more time and choose Escape Menu to prevent the popup menu from automatically popping up 
when you no longer want it to do so.  You can remove unwanted fit markers in two different 
ways.  If you choose Kill All Fit Markers from the popup menu, you will erase all existing 
markers.  This is often the easiest approach.  You can also delete individual fit markers by place 
the blue plus sign over the fit marker and then choosing Delete from the popup menu or entering 
the Del key stroke.  This might seem difficult since it is difficult to know exactly which channel 
the fit marker is in.  To help with this problem, the “+” marker turns yellow (“+”) when it is 
placed in the same channel as a existing fitmarker.  Another helpful tool is to move the plus 
marker with the ALT+arrow keystroke combination.  Rather than moving the plus sign by one 
channel, the plus sign will be moved to the next fitmarker.   

 
There are five steps required to define a valid set of fit markers:  
1) Use one marker to define the starting location of the fit and the type of the fit.  There 

are five types of spectral fits available.  The list includes: single species fingerprint fit 
(F), dual species fingerprint fit (2), triple species fingerprint fit (3), four species 
fingerprint fit (4), and five species fingerprint fit (5). 

2) Use one marker to define the end of the fit.  This marker is always X.  

 
Figure 14.  Pop-up menu with fitmarker options. 
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3) Use one or more pairs of brackets ([,]) to define regions of baseline where there is 
little or no absorption. 

4) Use one pair of circles (o) to define a region where the laser is turned off. 
5) Use one marker (^ or *) to mark the spectral peak position for each species. 

 
An example of properly defined fit markers is given in Figure 15.  The regions enclosed by a pair 
of brackets ([ … ]) are used by the program to generate a first approximation to the shape of the 
baseline underneath the peaks.  The region enclosed by circles (o … o) is used to define the 
detector output corresponding to the absence of laser light.  The carats (^) denote the location of 
the main peak and can also be entered numerically under the Species Specific Fit Parameters 
menu. 
 

 5.3 The species specific fit parameters 
The Species Specific Fit Parameters are accessed under the Edit menu. The page is 

shown in Figure 16.  There are sixteen tabs available - one for each of the sixteen potential 
species which can be fit.  Each tab has several parameters that define the fit parameters for that 
molecular species.  TDLWintel uses a spectral fitting method that we call fingerprint fitting.  
Fingerprint fits take full advantage of and require complete knowledge of the species’ 

 
Figure 15.  Appropriate fitmarkers for nonlinear least squares spectral fit. 
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spectroscopy.  At the start of a fingerprint fit, the program calculates a spectral template for each 
species in the fit.  This template can be quite complex, consisting of up to 1000 individual 
spectral lines each described by a Voigt line profile. The calculation of this template requires 
knowledge of the temperature, the pressure and the tuning rate function for the laser.  The 
unknowns in the fit are simply the concentrations of each species and the definition of the 
frequency scale – that is the absolute frequency of any one point in the spectrum.  

 
These first two parameters in the menu relate to defining the origin of the frequency 

scale.  The Peak Position is the channel number corresponding to the Fingerprint Fit 
Frequency.  The Fingerprint Fit Frequency is the frequency of one of the peaks being used – 
usually the strongest line.  The Fingerprint Fit Frequency is specified in this menu – it is not a 
parameter in the fit.  The Peak Position is a parameter in the fit and it can either be fixed (if the 
position is known and is stable) or floated if you would like the fit to determine the position.  If 
the Peak Position is floated (determined by the fit), the value entered in the menu will be used as 
a first guess for the Peak Position.  This peak position menu item is equivalent to the peak 
position described in the previous 
section as the location of the “^” 
or “*” fitmarkers.  Although the 
Peak Position value can be 
entered numerically in this menu, 
it is usually entered graphically 
using the popup menu as 
described in the previous section.  
If the peak position is floated, 
then the peak position fitmarker 
appears as a black asterisk (“*”).  
If the peak position is fixed, then 
the peak position fitmarker 
appears as a blue carat (“^”). 

 
 The Species 

Concentration is usually floated 
since the point of fitting is to 
learn the concentration.  
However, it can be fixed if 
desired.  This is often useful to 
either generate a spectral 
simulation or to investigate an 
attempted fit which is failing to 
converge.  There is also an option 
to fix the concentration of this 
species to that of another.  This is 
useful if the species has strong 
spectral lines in one fit and weak 
lines in another.  

 

 
Figure 16.  Species specific fit parameters. 
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The Hit file is a table of spectral lines used to simulate the spectrum in this region.  The 
name Hit is used because the line list must be in HITRAN format.  The HITRAN line list format 
is defined in the chapter on file formats at the end of the manual.  Briefly, each line of the line 
list specifies the line strength and absolute frequency for one spectral line attributed to one 
molecule.  The Hit files should be located in the C:\HIT folder.  The Browse button allows you 
to search your computer for Hit files.  If the hit file is found in a different folder than C:\HIT, 
then a copy of the hit file will be moved to C:\HIT.  The Show Frequencies button allows you to 
see the line positions after they are extracted from the Hit file.  This button is very useful for 
providing an overview of all species that are being fit. 

 
There are several checkboxes at the bottom of each tab.  Two deserve special mention.  

The option to float the peak position even during frequency lock overrides the default rule of 
fixing all peak positions (in Field 1) during frequency lock.  This is sometimes useful for strong 
absorption lines at the edge of the frequency sweep where the laser tuning rate may be slightly 
unstable.  There is also an option to fit this species at ambient pressure.  This allows the software 
to measure and account for spectral absorption which occurs outside of the low pressure 
absorption cell.  This is particularly useful when monitoring carbon monoxide. 

 
The yellow command buttons beneath the tabbed dialogs allow you to manipulate species 

specific fit parameters more easily.  The “Share All Edits with All Fields” button will transfer the 
existing fitting parameters for all 16 species to all other fields.  The “Export this Species” button 
allows you to send the fitting parameters for one species in this field to another field.  Finally, the 
“Change Species Number” button allows you to rearrange the order of species specific fitting 
parameters. 

 
Before leaving the topic of fit parameters, we should address the issue of multiple fits.  

For example: how many fits can be requested at once and in what combinations?   The basic rule 
is that the total number of species in all specified fits cannot exceed sixteen.  Another important 
point is that the specified fits are performed from left to right across the screen.  Species number 
one is always associated with the first or left most fit.  Hence, if you specify a fingerprint triplet 
fit on the left of the screen and a fingerprint singlet on the right, then species one through three 
will be fit using the three species fit and species number four will be fit using the singlet fit. 

 
This leads to an interesting question about multi-species fingerprint fits.  How can each 

species in the fit have its own Fingerprint Fit Frequency?  Can there be more than one 
frequency scale?  No, there cannot.  The Fingerprint Frequency associated with the first 
species in the multi-species fit determines the frequency scale – the other Fingerprint Fit 
Frequencies are ignored.  Doesn’t this also imply that the Peak Position parameters for these 
species are also irrelevant?  Almost, but not quite.  They are not used to establish the frequency 
scale, but they are used by the program to estimate the concentrations of all species at the start of 
the fit – that is the peak positions are assumed to point to strong absorption features which can be 
used to provide a first guess of concentration for each species.  So it is good practice, though not 
essential, to specify the Peak Position for all of the species in a multi-species fit. 

 
A final warning about nonlinear least squares fitting.  This is an inherently multidimensional 

problem.  The method is very good at finding the best answer once it is close to the right answer.  
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However, if the fit begins with a poor initial guess for any parameter, it is easy for the search to 
become lost and to never converge.  Hence it is very important to provide good first guesses for 
the fit.  This is accomplished by 1) specifying Peak Position in the menu or equivalently putting 
the */^ fit markers on the peaks, and 2) placing multiple pairs of polynomial fit markers ([ … ]) 
in regions with no interfering peaks.  If you are having trouble getting a fit to converge, the best 
thing to do is to fix all the parameters (including concentration) at “reasonable” values.  When 
you ask for a fit, you will be shown the initial guess since no parameters are allowed to vary.  
Usually, it will be apparent which parameter is bad and how to fix it. 
 

5.4 The laser tuning rate 
The laser tuning rate must be defined to properly execute the spectral fits.  We give an overview 
of the procedure here.  There is also a step by step guide to determining the tuning rate function 
in an appendix.  As we described above, the tuning rate is represented by a numerical function 
based on a cubic spline interpolation of the positions of etalon peaks.  The tuning rate function is 
determined using TDLWintel’s Get Tune Rate from Etalon utility (under the Command 
menu) which automatically determines the tuning rate by analyzing a frequency scan acquired 
with an etalon inserted in the beam path.  See Figure 17. We typically use an etalon with a free 
spectral range of 0.05 wavenumbers.   
 

 
Figure 17.  Numerical analysis of etalon spectrum to determine laser tuning rate.  
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 When using the etalon-based tuning rate utility, there are a few points to keep in mind.  
The very beginning of the spectrum does not usually contain well defined fringes.  Typically, the 
first 10 or 20 points should be skipped.  The starting point must be defined by the user based on 
good judgment and on the result of the fit to the fringes.  The starting point is indicated by 
placing a fit marker (N) at the appropriate location.  At the user’s option, a second N fitmarker 
can be placed on the trace to indicate the end of the scan.  This is often useful to avoid false 
extrema associated with the abrupt shutoff of the laser at the end of the spectrum.  After the 
utility is invoked, it will draw white carats (^) at the positions of each of the maxima and minima 
in the scan.  It will also draw yellow vertical lines that show how well the tuning rate model 
reproduces the positions of the maxima and minima.  Sometimes there are extra carats or 
misplaced carats due to noise in the spectrum.  If this happens, vary the position of the N fit 
marker to exclude bad regions or invoke a binomial filter to smooth the etalon fringes.  The 
smoothing option is under the Toggle control.  A filter order of 5 to 9 is very often helpful.  A 
higher order filter may distort the spectrum enough to change the returned tuning rate. 
 
 The tuning rate that the program derives from the etalon spectrum is automatically stored 
in the menu for the currently displayed field.  In most cases, if you are happy with the new 
tuning rate, you will want to copy it to all four fields.  There is a command to do this under the 
Command menu or you can simply use the keystroke Ctrl-u. 
 
 Now, that all three tasks are accomplished, you should be able to execute non-linear least 
squares fits to your spectral data.   You can test this by returning the program to Display Mode 
while observing a typical spectrum.  You can then command the program to do a single fit by 
invoking the “Do a Spectral Fit” command under the Command Menu or simply by typing ctrl-n.  
A blue trace should appear that closely follows the green spectra waveform.  The blue trace is the 
result of spectral fit. 

6. Taking Data in Stream Mode 
6.1  Overview 

 Stream mode is the data acquisition mode which is used to produce a continuous stream 
of concentration or mixing ratio measurements.  This is the most commonly used method for real 
time data acquisition and analysis.  The data stream can have time resolution as small as 20 ms 
(depending on the complexity of the spectral fitting).  The software can remain in Stream mode, 
continuously collecting data, indefinitely. 
 
 Since Stream mode continuously performs nonlinear spectral fits to return molecular 
concentrations, it is imperative that the fits be set up properly and that they remain valid for the 
duration of the measurement.  The usual approach to setting up the fits is to do so in Display 
mode, using a spectrum that is representative of the data which will be collected in Stream 
mode.  This is done following the procedures presented in the previous chapter.  Once the sample 
fit looks good, it is safe to enter Stream mode using the Data Aqn. State control (see Figure 2).  
It is also possible to start stream mode using the “F1, S” keystroke combination.  “F1, S” means 
F1 followed by S – not simultaneous keystrokes. 
 
 Upon entering Stream mode, the program should begin fitting each spectrum as it is 
acquired.  The results of these fits should be relayed to the Mixing Ratio vs. Time window.  
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Open this window to verify that data is being displayed there in the form of a stripchart.  Stream 
mode attempts to provide the same time resolution as Current Signal mode.  In other words, the 
time resolution is controlled by the Data Update Time which is under the Edit/Timing 
submenu.  If performing the nonlinear fits takes more time than the Data Update Time, then the 
time response will not be as fast as expected.  Sometimes, turning on the Guess Last option 
under the Toggle control can provide more speed if necessary. 
 
 Although starting stream mode is straight forward once the spectral fitting is properly 
setup, there are a number of variations or modifications to stream mode that need to be 
considered to make it work most effectively.  Two of these topics are always relevant and will be 
discussed in this chapter:  data storage (Write Data method, RS232 method and Automatic 
Spectral Save method) and frequency locking (Frequency Lock method).  Other modifications to 
stream mode will be discussed in subsequent chapters.  These include the Pulse Normalization 
method, the Calibration method and the Automatic Background method. 
 

6.2 Data Storage 
 There are two primary types of data which are produced by TDLWintel: stream data and 
spectral data.  This was discussed previously in Section 4.2.  Spectral data are stored in either in 
ASCII .spe files or, more often, in binary .spb files.  As discussed elsewhere, the SPE file 
contains the spectrum, the fit to the spectrum, the tuning rate and most of the parameter settings 
from the menu.  It is the primary record of each data point.  Whereas SPB archives contain many 
spectral waveforms compressed into one file, but do not contain fitting information, tuning rates 
or menu parameters.  Stream data is created by analyzing a spectrum to produce one or more 
concentrations and a time stamp.  Stream data is highly processed.  The basic storage mechanism 
for stream data is that is stored in a .str file.  A parallel file containing several experimental 
variables as a function of time can also be created.  It is called the stream conditions file (.stc).    
There are options for automatically storing both the stream and the spectral data. 
 
 The automatic storage of spectral data is accomplished with the Automatic Spectral Save 
method.  This method is invoked with one of the toggle buttons (ASS) and configured under the 
Edit menu.  We recommend storing all spectral data if possible.  The spectra are the primary 
data record and can be reanalyzed if concerns about the stream data arise after the experiment.  
These concerns could involve an 
unknown spectral interference or an 
improperly calibrated pressure gauge.  
Since the spectra are stored in binary 
archives, the storage space 
requirements are not severe.  A 
typical single laser instrument 
running continuously at 1 Hz and 
saving every spectrum will use only 
200 MB/day or 6 GB for one month.  
Hence an instrument computer 
starting with 100 GB of free space 
could save and store a spectrum every 
second for more than a year. 

 
Figure 18.  Automatic Spectral Save configuration 
page. 
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 The Auto Spectral Save configuration page is accessed by right-clicking on the ASS 
toggle button.  The page is shown in Figure 18.    The Save Frequency option allows the user to 
save a fraction of the total number of spectra which are acquired.  This is obviously useful for 
reducing the total amount of archived data.  Again, we recommend saving all spectra where 
possible.  If it is not possible, this option allows a fraction to be saved.  Note that there are three 
different types of spectra whose “save frequency” can be individually adjusted:  Sample Spectra 
(most important), Ref Spectra or frequency lock spectra and PNorm or pulse normalization 
spectra.  The sample spectra are acquired in Field 1, the PNorm spectra are acquired in Field 2 
and the Ref spectra are acquired in Field 4.  
 

In general, spectral files are saved is SPB format and with a name based on the date and 
time that the spectrum was acquired.  The “autosave.spe” option creates an additional SPE file 
with a well defined name that can be searched for by other programs that may want to display the 
latest spectral data.  

 
When Sample spectra are saved, the normalized version of the spectrum is saved.  Hence 

if the AutoBG method is enabled, then 
the program saves what is displayed in 
Field 1 – in this case the ratio of the 
sample spectrum to the background 
spectrum.  The save RAW option causes 
the program to also save a version of the 
sample spectrum that has not been 
divided by the background spectrum. 

 
The save Residuals spectra saves 

the difference between the sample 
spectrum and the fit to the sample 
spectrum.  This can be useful for looking 
for weak absorption lines in the presence 
of stronger lines. 

 
Finally, the “automatically 

organize…” is a handy feature that 
directs the program to place all 
automatically saved spectra for a given 
day in one folder that is created by the 
program and whose name is that date.  
 
 We now turn our attention to the 
stream data – that is the processed 
concentration versus time data.  The 
stream data are derived by fitting the 
spectral data.  As implied above, a 
different set of fitting parameters will  

Figure 19.  Write Disk menu options. 
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produce a different set of stream data.  Hence the stream data are derived from the spectral data 
and the stream data are NOT the primary experimental data.  The stream data DO provide real 
time feedback to the experiment operator.  There are three digital methods of sharing/archiving 
the stream data: 1) Write to Disk, 2) Write to RS232 port and 3) Write to Transient File.  In 
addition, there are supplementary data, so called stream conditions data, that can be saved to disk 
in parallel with the stream data. 
 

The simplest method for saving stream data is to store the data stream to the hard disk.  
This is accomplished by clicking on the wd toggle.  Once this is activated the result of each fit 
generated in stream mode or burst mode (including a high resolution time stamp) is saved in a 
file with extension “.str”. 
 

The second method of data logging is to use the RS-232 port to send digital data to 
another computer or data logger.  This is accomplished with the RS toggle. The same data is 
transmitted that is being written to disk – the mixing ratios and a time stamp.  This method can 
also be configured by right clicking on the toggle button.  The configuration page allows you to 
specify the serial port parameters (baud rate and port number) as well as the format of the data 
line. 
 

The third method of logging data is to write the data to a transient file.  The file is called 
transient because it is a temporary storage location.  The purpose of the transient file is to share 
data with another computer program in real time.  TDLWintel creates a transient file and 
appends data to this file as it becomes available.  Unlike the stream file, the transient file is 
closed except when it is being written to.  This means that it is available to be read from almost 
all of the time.  Typically, the transient file will be accessed by another program which will read 
all of its data and then erase the transient file.  This transient file concept is a very flexible 
construct.  The receiving program can do many things with the incoming data.  The transient file 
can be used for direct data logging, data display or for transmission through a serial port or 
across the internet.  The transient file can be located anywhere on the local area network – as 
long as the drive has been mapped by the TDLWintel computer.  The transient file option is 
activated when the Write Disk toggle is invoked if the Write Disk method is configured to do 
so.  More details of this transient data sharing technique are presented in an appendix. 

 
The configuration page for the Write Disk method is selected by right clicking the wd 

toggle button (see Figure 19).    In the upper section, several file options are offered.  These 
allow the user to choose which files are created when the Write Disk toggle is invoked.  The 
first two options are active by default.  These two choices are the standard archival stream file 
(*.str) and a file called the stream conditions file (*.stc).  The stream conditions file contains 
information about temperature, pressure, laser intensity, peak positions and goodness of fit for 
each line of the stream file.  The fourth and fifth options are to write to the transient stream file 
and stream conditions file which have been discussed above.  The other two file options are 
highly specialized and not generally used.    In the second section of the configuration page, the 
user can select a name for the transient file and a disk drive for its location.  At the bottom of the 
menu are two very useful options that we highly recommend that you always use. 
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6.3  Frequency Lock 
Frequency stability is a very important topic in stream mode.  Before entering stream 

mode, you acquired one sample spectrum and set up the fit parameters so that the fit worked 
well.  Next you entered stream mode and the fit continued to work well – we hope.  Presumably, 
you were monitoring a strong absorption feature and the fit converged whether you chose to fix 
the Peak Position at the observed location or to float it.  This works well for short periods of 
time and especially for strong peaks, but for long periods of time, the frequency of the laser may 
drift – depending on the type of laser being used.  Hence, we need an effective strategy for 
dealing with frequency drift.   

 
TDLWintel manages laser 

frequency drift using the Frequency 
Lock method.  The Frequency Lock 
method uses a strong absorption line to 
measure the laser frequency, to account 
for any frequency drift and to correct for 
this drift when necessary.  In some 
cases, the strong absorption line may be 
present in the sample spectrum.  In other 
cases, it may be necessary to employ a 
reference gas contained in a sealed 
reference cell.  Both approaches are 
supported in TDLWintel.  In either case, 
the reference spectrum is stored and 
analyzed in Field 4 with the peak 
position floated so that it can be 
determined in the fit.  If a sealed 
reference cell is used, the reference gas 
in the cell can be any gas with 
absorption lines in the right frequency 
window – it does not need to be the 
same as the sample gas.  When the 
frequency lock method is on, the peak 
positions in the sample field (Field 1) 
are always fixed.  As the peak position 
drifts, this drift is measured in the 
Reference Field and appropriate 
adjustments to the peak positions in the 
Signal Field are performed.  If multiple 
species are fit in Field 4 only the 
position of the first species in the fit is 
used to determine the laser frequency.  
If more than one laser is being used, 
then there will be multiple separate lock 
points – one for each laser.  For small 
drifts, TDLWintel simply observes the 

 
Figure 20.  Frequency Lock configuration page. 
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drift in Field 4 and makes appropriate corrections to the Field 1 peaks positions to account for 
this drift.  If the drift becomes too large, then TDLWintel corrects the laser frequency to move it 
closer to its original frequency. 

 
The configuration page for the frequency lock method is accessed by right clicking the 

frequency lock toggle button (“flk4”).  The “4” indicates that the frequency lock spectrum is 
always stored in Field 4.  The configuration page is shown in Figure 20.   
 

Under the global frequency lock parameters, we can specify the lock timing and the lock 
source.  The default is that the lock is performed continuously at the same rate as data is being 
acquired in Field 1.  However, a slower rate for the frequency lock can be specified by checking 
the Semi-Continuous checkbox and then specifying a “Lock Interval”.  In some cases this is used 
simply to spend less time doing the frequency lock.  For example, if data is being acquired at 10 
Hz, it might suffice to check the frequency lock at 1 Hz.  The other common reason to use this 
feature is if the frequency lock is implemented with a sealed reference cell that shares a detector 
and must be flipped into the optical beam to be used.  In this case frequency lock will be 
performed much less frequently (perhaps once per minute).  To exercise this option you should 
check the toggle valve option.  If you do so, there is a further option to set the phase of the 
frequency lock by specifying its start time. 

 
The Lock Source options allows you to select the source for frequency lock spectrum.  

Select Signal Lock to lock to the sample spectrum in Field 1.  Select PN Lock to lock to the 
Power Normalization spectrum in Field 2.  This choice makes sense when using the Null option 
under the Power Normalization method which is discussed in a subsequent section.  It is also 
frequently used with the Toggle with Ref Check option in single detector instruments that share 
one detector for both power normalization and frequency locking to a sealed reference gas cell.  
The Ref Lock option acquires the frequency lock spectrum in Field 4 using the timing and AD 
settings for that field.  Typically, the beam path monitored in Field 4 is set up to pass through a 
sealed reference gas cell.  Finally, the Sig Lock without BG is an advanced option that allows 
you to lock to the sample spectrum as if the Automatic Background method were disabled even 
if it is enabled.  This is useful if the species that you are locking to is present both in the sample 
gas and the background gas.  In this case its spectral features are removed when Automatic 
Background is activated.   This option allows you to lock to these lines even though they are 
being removed from processed sample spectrum. 

 
Below the global frequency lock parameters there is a laser specific tabbed control which 

allows you to specify laser specific frequency lock parameters.  The five parameters at the top 
define basic properties of the lock method. The Lock Range or Deadband is the number of 
display points that the laser frequency is allowed to drift before making a correction to the laser 
frequency to resist the drift.  It can be set to less than one channel if desired.  The Lock Offset 
allows the user to define a difference between the lock position in Field 4 and that in Field 1.  
Normally, this should be set to zero.  The Laser Tune Rate refers to the derivative of the laser 
frequency with respect to laser temperature.  This is expressed in units of degrees Celsius per 
display point.   The Gain is used to attenuate the corrections applied by the frequency lock 
method in order to avoid possible oscillations.   The Lock Time Response is the amount of time 
required for the laser frequency to stabilize after making a frequency correction.   During this 
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time period, the program will refrain from making further laser frequency adjustments. This 
parameter is important since the laser frequency may oscillate if this parameter is too small.  In 
general, oscillation problems can be avoided by reducing the gain and/or increasing the time 
response. 

 
There are three checkboxes at the bottom of the laser specific parameters. There is an 

option to lock the peak position to a specific channel number.  This is almost always used.  There 
is an option to suppress the frequency lock if the peak absorbance in the frequency lock spectrum 
becomes too small.  This is very useful when using sample lock.  For example, it allows the 
frequency lock to survive the addition of zero gas to the sample cell.  Finally, the Exclude 
Lasers from Frequency Lock option allows you to selectively choose which lasers to lock.   

 
Once all of the parameters are properly set, the frequency lock method is activated by 

clicking on the flk4 toggle button.  This will initiate spectral analysis in Field 4 to perform the 
frequency lock which will run in parallel to the sample spectral analysis in Field 1.  This requires 
that the fitmarkers in both fields be correct.  In particular, the peak position marker(s) in Field 4 
must be in the proper locations (near the reference peaks) or the lock will not initiate properly.  
The step by step procedure for properly initiating the frequency lock is discussed in Appendix A. 

7. Power Normalization Method 
The Power Normalization method is used to account for amplitude noise in the sample 

spectrum.  This method used to be called the Pulse Normalization method because it was first 
used with pulsed laser systems with large 
pulse to pulse amplitude variation.  The 
method worked by simultaneously 
monitoring the signal pulse train and a 
reference pulse train and using the reference 
pulse train to normalize the signal pulse 
train.  We have since extended this method 
to cw lasers and modified its name to reflect 
its broader utility.   

 
The configuration page for the 

Power Normalization method is shown in 
Figure 21.  There are three possible 
normalization methods which can be 
selected in the Normalization Method 
checkbox.  The first option is “Single 
Channel, Dual Trigger” which is only 
applicable to pulsed systems.  In this 
arrangement a single infrared detector is 
employed to detect both the signal pulse and 
the reference pulse – but they arrive at the 
detector at different times.  Hence there is a 
dual trigger.  The second option is “Dual 
Channel, Single Trigger” which can be used 

 
Figure 21.  Power Normalization 
configuration page. 
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either with pulsed or cw lasers.  In this case the signal and reference beams are detected by 
separate detectors but at the same time using a single trigger.  The final option is intended for 
pulsed lasers only.  It is called “Dual Channel, Dual Trigger.”  In this case the signal pulse and 
the reference pulse are detected on separate detectors at separate times.   

 
The next item in the configuration page is a checkbox that allows the power 

normalization to be applied to the frequency reference spectrum.  We generally recommend 
checking this box to take advantage of this feature.   

 
The next section of the page selects whether or not to use the Null method.  The Null 

method is a special version of power normalization.  Instead of normalizing the sample spectrum 
with a spectrum obtained by directly monitoring the laser output, a spectrum that passes through 
a reference cell is employed.  Typically the reference cell contains a fixed mixing ratio of the gas 
being measured in the sample path.  By dividing the sample spectrum by the reference cell 
spectrum, one obtains a spectrum with no net absorption when the sample column density equals 
the reference column density.  This greatly reduces noise that is proportional to the mixing ratio 
as well as laser amplitude noise.  This method was developed to improve the precision of carbon 
dioxide isotope ratio measurements.  If this method is used, you must provide mixing ratio 
values for the reference gas.  This can be done by clicking on the Set Null Parameters button.  
The Null method is described in more detail later in the manual. 

 
The four parameters at the bottom of the menu page complete the configuration of power 

normalization.  The “Delay for reference pulse” and the “Delay before signal pulse” are the 
number of nanoseconds between the time that the laser trigger pulse occurs and the time of the 
respective analog to digital conversions.  These timing parameters are critical for pulsed 
operation.  The other two parameters are the AD input channel and gain for the reference path.  
All four of these parameters are presented here for convenience but can also be set directly by 
editing these parameters in Field 1 or 2 respectively.   

 

8. Automatic Calibration and Automatic Background Methods 
8.1  Overview 

 Each of these methods performs an important function periodically without operator 
intervention.  The automatic calibration method will periodically acquire a spectrum of a 
calibration gas in the sample cell and record its measured mixing ratio.  The automatic 
background method periodically acquires a sample spectrum with the sample cell filled with dry 
nitrogen.  This background spectrum is used to normalize future sample spectra.  At the very 
least, this will eliminate curvature in the baseline due to the varying intensity of the laser source.  
Being able to analyze the spectrum on a flat baseline leads to improved accuracy.  When the 
Auto Background method is performed very carefully, this technique can also remove etalon 
interference fringes from the signal spectrum providing significantly enhanced sensitivity.  Each 
of these methods is activated using a toggle button in the Toggle control.  Each of these methods 
is configured by right clicking on the respective toggle button – either cal or abg. 
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8.2   Automatic Background 
The Automatic Background method is used very frequently and is straightforward to 

implement.  The Automatic Background method periodically replaces the sample gas stream 
with a gas stream that lacks the target gas.  This is accomplished by toggling a three way 
solenoid valve on a periodic schedule that can be defined in the configuration page (see Figure 
22).  The solenoid valve used to acquire the 
background spectrum must be Valve #2.  This 
is not adjustable.  Usually the background gas 
is dry nitrogen, although more elaborate 
designs are some times used.  The 
background spectrum is acquired in Field 3.  
When Automatic Background is activated the 
sample spectra in Field 1 are divided by the 
background spectrum in Field 3 producing a 
transmission spectrum with a range of 0 to 1.  
This transmission spectrum is scaled by a 
factor of 1000 mV and displayed in the Field 
1.  Hence, sample spectra appear as 
absorption features on a flat 1000 mV 
background. 

 
The configuration page for Automatic 

Background allows the user to adjust four 
parameters and to activate seven checkboxes.  
The first variable is the Auto Background 
Interval.  This interval is simply the time 
between the initiations of successive 
background acquisitions.  The Auto 
Background Duration variable is the 
amount of time spent acquiring the 
background spectrum.    The Cell Flush 
Time is the time required to fully replace the 
contents of the sample absorption cell.  This 
is equivalent to the synonymous parameter 
under the timing menu and the auto 
calibration menu.  The starting time is the 
time that defines the initiation of the series of 
background measurements.  This parameter is only used if Specify starting time for cycle is 
checked.  Otherwise the background cycle begins as soon as the abg toggle is activated. 

 
To present a concrete timing example, consider the timing parameters in Figure 22.  The 

interval is set to 300 seconds which means that a cycle will begin every five minutes.  Since the 
starting time is set to midnight, these background acquisitions will begin on the hour and every 5 
minutes thereafter.   Consider a particular background acquisition that begins at 8:10.  At 8:10:00 
the acquisition begins with the activation of the background valve.  Since the flush time is set to 
10 seconds, the period from 8:10:00 to 8:10:10 is neither pure sample nor pure background and 

 
Figure 22.  Automatic Background 
configuration page. 
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spectra acquired during this time are discarded.  The actual background spectrum is acquired 
between 8:10:10 and 8:10:40.  All spectra acquired during that time window are averaged to 
create a background spectrum which is stored in Field 3.  At 8:10:40 the background valve is 
deactivated which begins a second flush period.  This flush period ends at 8:10:50.  At this time 
normal sample spectra are acquired again.  The total time used to acquire the background 
spectrum is therefore 50 seconds.  Thirty seconds are spent acquiring the background spectrum 
and twenty seconds are spent flushing the cell. 

 
There are several check boxes at the bottom of the page which allow Auto BG to be 

further customized.   The Specify starting time for cycle option was discussed above.  The  
Switch Valve but don’t do ratio option causes the program to activate the Auto Background 
valve according to the specified timing but to not acquire or use background spectra.  This can be 
useful if two instances of TDLWintel are running on the same instrument but only one instance 
needs to use the automatic background method.  The Do Ratio but don’t switch valves option 
does the opposite.  The Do BG on External Command option allows background acquisitions 
to be triggered by another program or process.   This is described in the appendix on 
TDLWintel’s External Command Language.  If this option is selected, then the timing 
parameters at the top of the configuration page are ignored.  The “… save raw spectrum…” 
option instructs TDLWintel to save a set of spectra without the BG spectrum applied when Auto 
Spectral Save is turned on.  The Slide BG option is not supported at present.  Finally, the Save 
Flush Spectra option instructs TDLWintel to save spectra while the cell is transitioning between 
sample and background.  These spectra are labeled FNF (neither fish nor fowl) and are only 
saved if Auto Spectral Save is active. 

 
 

8.3  Automatic Calibration 
Automatic Calibration 

periodically replaces the sample gas 
stream with a calibration gas stream.  
This is accomplished by toggling a 
three way solenoid valve on a 
periodic schedule that can be defined 
in the configuration page (see Figure 
23).  The solenoid valve used for the 
calibrations must be Valve #1.  This 
is not adjustable.  The calibration 
spectrum is analyzed using the same 
fit markers and parameters used to 
analyze the sample.  The results of the 
calibration gas analysis are written to 
a special file.  There is one file 
created for each day.  Its format is 
identical to that of a normal stream 
file but it has a slightly different 
name.  The format for the name is 
“yymmdd_CAL.str”.    

Figure 23.  Automatic Calibration configuration page. 
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Several of the calibration cycle parameters are analogous to those defined above for the 

automatic background method.  The calibration cycle timing is defined by the four parameters at 
the top of the calibration page.  The Calibration Interval is the time between the start of one 
calibration cycle and the start of the next calibration cycle.  The Calibration Duration is the 
amount of time spent actually acquiring calibration spectra.  The Cell Flush Time is the time 
required to fully replace the contents of the sample absorption cell.  This is equivalent to the 
synonymous parameter under the timing menu and the auto background menu.  The starting time 
is the time that defines the initiation of the series of calibrations.  This parameter is only used if 
Specify starting time for cycle is checked.  Otherwise the calibration cycle begins as soon as 
the cal toggle is activated.  The Report CAL even during flush time option instructs the 
programs to perform fits during the transition periods between sample and calibration gas and to 
include the results in the calibration file.  If the Report Results at Refit Rate option is checked, 
then the program will divide the Calibration Duration into individual spectra and report several 
calibration values for each calibration cycle.  If it is not checked, then the program will average 
all the spectra acquired during the Calibration Duration and will analyze only this average 
spectrum providing one calibration value per calibration cycle.  The Open BG Valve with CAL 
option causes the program to open both the calibration valve and the BG valve when performing 
calibrations.  This can be useful when calibrating with a permeation tube.  Finally, the Do CAL 
on External Command option allows calibrations to be triggered by another program or 
process.   This is described in the appendix on 
TDLWintel’s External Command Language.  
If this option is selected, then the timing 
parameters at the top of the configuration page 
are ignored. 
 

9. Burst Mode 
Burst Mode allows TDLWintel to 

acquire spectra with very high time resolution 
for finite time periods (up to a few seconds).  
This burst of data is initiated with a trigger 
event.  Burst mode acquires a series of spectra 
before and after this trigger event.  These 
spectra can be displayed, saved and/or 
analyzed.  The spectra before the trigger can 
be used to normalize those after the trigger if 
desired.  Burst Mode is turned on by selecting 
it in the Data Acquisition State control at the 
top, left of the display.  Before turning on 
Burst Mode, you must configure it.  There are 
several software options.  In addition the 
trigger pulse must be connected. 
 
1)  Your trigger pulse should be connected to 
PFI1 on the National Instruments BNC panel. 

 

 
Figure 24.  Burst mode configuration page. 
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2)  The software options are selected in the pull down menus under Edit\Burst Mode.  Let me 
describe each option: 
 a)  The only choice under Trigger Type is Digital Pulse.  This may be extended in the 
future. 
 b)  Trigger polarity selects which edge of the trigger pulse is used. 
 c)  Post Burst  determines whether you stop taking data after the event to examine the 
spectra or whether you immediately prepare for the next trigger. 
 d)  Background Ratio determines whether the spectra taken after the trigger are 
normalized by the average of the spectra taken before the trigger.  Using the background ratio 
will reduce systematic noise in the spectra. 
 e)  Aggregate Spectrum determines whether the average of all the spectra taken after the 
trigger pulse is saved to disk.  This does not save the series of spectra - just the average of the 
series.  If you want to save the entire series, you should select the Auto Spectral Save option 
(ASS) under the Toggle Status control at the bottom of the TDLWintel application window. 
 f)  The pretrigger duration controls how much time before the trigger pulse is used to 
measure the pretrigger or background spectrum. 
 g)  The burst duration controls the length of time that spectra are measured after the 
trigger pulse. 
 h)  The time resolution determines how many individual laser sweeps are used to create 
each spectrum in the series.  This time can be as small as the time it takes to acquire one sweep 
or can be made larger to improve sensitivity at the expense of time resolution. 
 

The pretrigger duration, the burst duration and the time resolution are each expressed in 
units of milliseconds. 
 

After a series of spectra is acquired they will be automatically analyzed if a nonlinear fit 
has been defined using the fit markers.  The concentration determined in the fits will be 
displayed in the concentration stripchart window.  If you also want these results to be saved to 
disk, select the Write Disk option (WD) under the Toggel Status control.  If you want to save the 
spectra to disk, select the Auto Spectral Save option as described above. 
 
 

10. Playback Mode 
The Playback mode provides a method for redisplaying or reanalyzing previously 

acquired spectra.  This can produce a spectroscopic movie which can be displayed during 
presentations or at meetings.  More typically, the playback mode is used for batch reanalysis of 
archived spectral data.  The spectra that will be played back must be stored in the binary format 
(*.spb) and each spb file must have a matching spe file with the identical name (excluding 
extension). 

 
The first parameter to select is the playback folder.  This is selected in the frame labeled 

“Input Files”.  The program searches the selected folder for binary spectral files.  All valid binary 
spectral files will be analyzed.  For a file to be valid, the spe file with the same base name must 
be present in the same folder.  Also, the spectral file must not be excluded by the filtering 
performed under the “Details” button.  This filtering allows you to exclude spectral files by type.  
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At present, the various types are: 
CAL (calibration), BG 
(background), REF (frequency 
lock), FNF (“fish nor fowl” spectra, 
those taken at intermediate times 
between sample and cal or sample 
and background or sample and 
frequency lock), PN (power 
normalization), RAW (sample 
spectrum without BG spectrum 
applied) and SIG (sample).  The 
“Details” button also allows you to 
instruct the program to search for 
binary spectral files in subfolders of 
the selected playback folder and to 
search only during specified time 
windows. 

 
The Timing frame allows 

you to control the pace of the 
playback.  If you use the Refit Time, 
then the files will be reanalyzed at 
the same rate as they were acquired.  
This is useful for presentations.  
You can also control the replay rate 
by choosing the Select Interval 
option.  With either of these choices 
the fits are displayed but no output 
file is created.   

 
A third choice is to select the 

option to reanalyze the data as Fast 
as Possible.  This is the correct 
choice for reanalysis.  With this 
selection there is no pause between 
analyzing subsequent spectra.  The results of the fitting are written to special stream files (*.str) 
inside the Playback folder. 

 
The final choice is Frame by Frame.  This allows you to step through the data spectrum 

by spectrum or to jump to any spectrum of your choice.  No output file is created.  When this 
option is selected, a control appears in the bottom panel of the main TDLWintel display (See 
Figure 26).  At the top of the control is the name of the binary spectral archive that is currently 
loaded and an indication of how many archives were found in the playback folder.  In this case 
we are looking at spb file number 1 out of 3.  Within this spb file, there are 395 individual 
spectra and we are currently viewing the first spectrum.  This control allows you to move 
forward or backward in time by clicking on the arrows.  Alternatively, a spectrum number can be 

 
Figure 25.  Playback mode configuration options. 
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typed into the text box.  Or, if you double click on 
either the time stamp or the date stamp for the current 
spectrum, you will be given the option to jump to a 
spectrum with any timestamp that you choose.   

 
Another option box allows the user to choose 

the fit parameters which are used to analyze the 
spectra.  For simply redisplaying spectra, the usual 
choice would be to use the fit parameters contained in 
the spectral file itself.  However for batch reanalysis, 
one usually wishes to modify some of the fit 
parameters.  This can be accomplished by loading a sample spectrum into Field 4 and adjusting 
the fit parameters in Field 4 to produce the desired result.  Playback mode is then executed with 
the option to use the Field 4 fit parameters or the Field 4 fit parameters with some exceptions.  
The exceptions than can be selected are pressure, temperature and peak position. 

 
The Optimize Spectral Grid option is only used for very specialized circumstances which 

will not be discussed here.  The BG Status checkbox must be properly set to allow proper 
processing of BG spectra.  If the spectra were acquired with automatic BG on, then this box 
should be checked to indicate that the recorded spectra are actually ratios of sample spectra to 
BG spectra. 

 
The BG Options frame presents several options for reanalysis using a variety of 

background spectra.  The options include refitting the spectra with no background, with a fixed 
background spectrum (which should be stored in Field 3), with a prior BG (the usual choice), 
with a subsequent BG or with both a prior and a subsequent BG.  With this latter choice, the 
spectrum is refit twice, once with each BG, and the reported result is the time weighted average 
of the two fits. 

 
Finally, there are additional options: 
 
1) To average spectra before reanalyzing them by typing in the number of spectra to 

be grouped in each average or by specifying an averaging time. 
2) To use the Null Method during reanalysis.  This is for spectra obtained using the 

null method option under the PN method 
3) To save each spectrum as an SPE file.  This converts all spectra to SPE format. 
4) To suppress fitting.  This is usually used in conjunction with option to convert to 

SPE in order to speed the process 
5) To shift the spectra in the archive in order to have the same peak positions as the 

first spectrum in the archive. 
 

 
Figure 26.  Control to View Binary 
Spectra. 
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Appendix A:  Step by Step Guide to Starting Data Acquisition 
The two most important points about starting the nonlinear spectral fitting are 1)  that the 

absorption line is in the right location and 2) that the peak position marker(s) in Field 4 is in the 
right place (on the absorption line).   Once this is accomplished it is simply a matter of clicking 
on the flk4 toggle button to launch the frequency lock method.  We present two procedures for 
accomplishing this: the automatic approach and the manual approach.   
 
Automatic Approach 

The simplest procedure is to use the Automatic Startup (AS) method.  If the AS method was 
active the last time that TDLWintel terminated, then when TDLWintel restarts it will 
automatically start data acquisition.  This procedure begins with the program switching to Field 4 
and tuning each laser’s temperature until it determines that the reference lines are in the correct 
place.  Then the program enters stream mode and activates each of the methods that were 
selected when AS was originally configured.  The automatic startup procedure can be time 
consuming typically requiring 5 minutes per laser to finish its work. 

 
But this procedure will only work if it 

was configured during a previous session.  
So that leads to the question:  How do 
you configure the AS method?  There are 
two steps to this.   

 
First, you should confirm that the 

parameters in the AS configuration menu 
are correct. You can examine this menu 
by right clicking on the AS toggle button 
(see Figure A1).  The parameters on the 
left of the menu configure the search 
parameters for finding the correct spectral 
window.  Typically, the default 
parameters are excellent choices.  
However, you can speed up the search 
process (if you find that the Automatic 
Startup is robust and could proceed more 
rapidly) or you can slow down the process if you find that the startup is unreliable.   

 
The parameters on the right of the menu include two checkboxes.  The checkbox to drop all 

lasers to their lowest temperature is only used for a few finicky lasers that have required this 
trick to operate reliably in single mode.  The checkbox to initiate automatic startup whenever 
frequency lock fails is quite useful and is frequently selected. 

 
The other parameters on the right hand side of the menu allow you to select which functions 

will be enabled after the search for the proper spectral locations is complete.  These functions 
include options like turning on the RS232 output or enabling automatic solenoid valve operation 
for selected valves. 

 
Figure A1.  Configuration page for the Automatic 
Startup method. 
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The second and final step to configuring the AS method is to acquire a spectrum under the 

same conditions that will exist when the Automatic Startup method is searching for the proper 
spectral window.  In many cases, this search will take place with the sealed reference cell 
inserted into the beam path.  Sometimes a different detector will be used.  Usually the spectral 
fitting parameters will be different during this search than under normal operation.  So how is all 
of this information entered into the configuration file?  The procedure for doing this is as 
follows: 

 
1) Turn off Power Normalization, Automatic Background, Automatic Calibration and 

Frequency lock in Field 1.  This puts the Fields in the independent operating mode. 
2) Put the absorption lines in the right place while in Current Signal or Stream Mode.  

Adjust laser temperature to do this. (This step can be done in Field 1 or Field 4). 
3) Switch to Field 4 and Current Signal.  Field 4 contains the frequency lock parameters.  

But we want to see and adjust the automatic startup parameters. 
4) Retrieve the automatic startup parameters (and hide the frequency lock parameters) by 

clicking on “Command\Show Autostart lock in Field 4”  
5) Make adjustments to see the spectrum that you want to use for Automatic Startup.  For 

example, choose the right detector by choosing the right AD input.  Also put the 
sealed reference cell in the proper state. 

6) Enter the correct fit markers and fitting parameters to fit the spectrum. 
7) Put the data acquisition system into Stream Mode. 
8) If the fits look good and the peaks are in the desired locations, then save this spectrum 

and these conditions by clicking on “Command\Update Autostart Spectrum” 
9) Click on “Command\Show Autostart lock in Field 4” to remove the check mark which 

indicates that the frequency lock parameters have been returned to Field 4 and the 
automatic startup parameters are hidden (in Field 5) 

10)  Finally, return to Field 1 and activate the AS toggle button with a left click.  
 

The Automatic Startup spectrum should only be updated when the program is operating in 
exactly the way that you want it to operate when it next restarts.  This spectral update only needs 
to be done occasionally.  For example, you might need to update the Autostart spectrum if you 
decide to operate in a different spectral window or if the spectrum in the sealed reference cell 
changes significantly.  The latter might happen if there is a small leak in the sealed reference 
cell. 
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Manual Approach 
The manual approach to starting data acquisition is usually the fastest approach, since you 

are undoubtedly smarter than the computer and able to locate the proper spectral lines faster.  
The procedure is as follows: 

 
 

• Turn off Power Normalization, Automatic Background, Automatic Calibration and 
Frequency lock in Field 1.  This puts the Fields in the independent operating mode. 

• Adjust laser temperature(s) to put peaks roughly in the “right” place.  If using Sample 
Lock, this can be done in Field 1 in Current Signal Mode.  If using Reference Cell Lock, 
then this must be done in Field 4 in Current Signal Mode.  In this case, it may be 
necessary to activate the Reference Cell Toggle. 

• Deactivate Reference Cell Toggle if used in previous step. 
• Go to Current Signal Mode in Field 1 and fix the peak positions (F2,a). 
• Go to Stream Mode.   
• Activate <PN> (if applicable). 
• Activate  <FLK4>. 
• Activate <ABG> (optional – zero air must be attached to system). 
• Activate <WD> and <ASS>. 
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Appendix B:  TDLWintel File Formats 
Overview 
  This section discusses file structures and data structures used by TDLWintel.  The files 
that are discussed include hit files, molecule files, configuration files, spectral files and stream 
files.  We also discuss the format of the digital concentration data which is exported through the 
RS232 port.  Most of the above files are saved in text or ASCII format.  If you edit them, be sure 
that you save the updated file as a text file.  It is safest to simply use Notepad for editing.  If you 
edit the file with Word or another word processor, make sure that you do NOT save the file as a 
Word or any other word processing document.  We begin with the hit files. 
 
Hit Files 
  Hit files are used to store the spectroscopic information required to fit a single species.  
These files can be stored anywhere on the computer but are usually saved under the Hit folder in 
the root directory – that is, in “C:\HIT”.  Hit files end with the “.hit” extension.  The Hit files 
follow the format of the widely used HITRAN data base.   
 

The HITRAN data base is a high resolution spectral data base concerned with 
atmospheric molecules.  Detailed information about this freely available data base can be found 
at www.hitran.com.  If the molecule that you are studying is in the HITRAN data base, you can 
simply extract the relevant lines from the database and use them to create your Hit file.  If the 
molecule is not in the HITRAN database or if the spectral lines that you are monitoring are not 
included in HITRAN, then you must create the Hit file yourself.  This is easy to do, but requires 
that you understand the format.  The format is available at the web site under 
Documentation/Download HITRAN paper.  We will give a brief description of the format here 
which is sufficient for the purpose of creating Hit files.  Note: the simplest approach to creating 
Hit files is to use the Igor macro described in Appendix G. 
 
 The HITRAN data base is a frequency ordered spectral line list.  Each line describes a 
single spectral transition of one molecule between two quantum states.  Each line in the line list 
consists of 100 characters.  For example, here are four lines extracted from an ammonia Hit file: 
 
 
 
111  963.924100 8.950E-22 2.376E-03.0798.2574  874.1501 .75 .000000  6  9 9 2 0  a 9 2 0  s004 0 0 1 
111  964.022500 2.120E-22 5.931E-04.0796.2057  884.9154 .75 .000000  6  9 9 1 0  a 9 1 0  s004 0 0 1 
111  964.041100 2.180E-20 1.890E-02.0821.4674  621.0657 .75 .000000  6  9 8 5 0  a 8 5 0  s004 0 0 1 
111  964.268400 1.190E-20 1.210E-02.0813.4112  653.8707 .75 .000000  6  9 8 4 0  a 8 4 0  s004 0 0 1 
 
The first two characters are the molecule number.  Each molecule in the Hitran database has 
been assigned a number.  The number for ammonia is 11.  The third character is the isotope 
number.  The value 1 indicates the major isotopic species. TDLWintel ignores this entry.  The 
next 12 characters are the molecular transition frequency in wavenumbers.  The next 10 
characters are the line strength (at 296 K) in units of cm2 cm-1 or cm.  The next 10 characters are 
the transition dipole moment – TDLWintel ignores this entry.  The next five characters give the 
air broadened half width (at 296 K) for the transition in units of wavenumbers per atmosphere.  
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The following five characters give the self-broadening coefficient in the same units.  TDLWintel 
ignores self-broadening.  The next 10 characters give the energy of the lower level of the 
transition with zero point energy removed.  The next 4 characters give the exponent for the 
temperature dependence of the pressure broadening.  This is the last entry that TDLWintel uses.  
The rest of  the line must be filled in with dummy values but those values are not used.   
 
 To summarize: TDLWintel uses the molecule number, the transition frequency, the line 
strength, the air broadened half width, the energy of the lower transition state and the 
temperature dependence of the broadening coefficient.  The last two parameters are used to 
calculate the temperature dependence of the line strength.  Hence, for work at or near 296 K, 
they are not very important.  If you are fitting a molecule that is not in the Hitran database, you 
must create your own hit file using the best available measurements or estimates for each of the 
parameters which TDLWintel uses.  For the molecule number, you should simply create your 
own number for the species that you are monitoring.  It would be wise to choose a molecule 
number greater than 50 to avoid conflicts with existing and future Hitran species.  Your choice of 
molecule number must be registered in the mol.dat file which is discussed in the next section. 
 
 Molecule File 
  Molecule files are used to store the names and numbers associated with different 
molecules as well as other molecule specific data.  There is only one molecule file and its name 
is always “mol.dat”.  Mol.dat must reside in the working directory, that is, the folder that 
TDLWintel is started from.  If TDLWintel is started without a molecule file, TDLWintel will 
create a basic molecule file which can be used to fit several common Hitran species – but not all 
Hitran species.  Any molecule number which is used in a Hit file, must also appear in the 
molecular file.  There is no penalty for including extra species in the molecular file.  The species 
included in the default file (and their species number) include water(1), carbon dioxide(2), 
ozone(3), nitrous oxide(4), carbon monoxide(5), methane(6), nitric oxide(8), sulfur dioxide(9), 
nitrogen dioxide(10), ammonia(11), nitric acid(12), hydroxyl radical(13), hydrogen fluoride(14), 
hydrogen chloride(15), chlorine monoxide(18), carbonyl sulfide(19), formaldehyde(20), 
hydrogen cyanide(23), acetylene(26), ethylene(38) and hydrazine(40). 
 
 
 The first 12 lines of the molecule file are: 
 
Hitran Species #, Name (4 letters max), MW, symmetry #, Q(296) if Q=0, next 3 lines read but 
not used 
partition function coefs for T<400:c0 c1 c2 c3 
partition function coefs for T<1500:c0 c1 c2 c3 
partition function coefs for T>1500:c0 c1 c2 c3 
1,"H2O",18,3,174.626 
 -.4440500E+01    .2767800E+00    .1253600E-02   -.4893800E-06 
  -.9432700E+02    .8190300E+00    .7400500E-04    .4243700E-06 
  -.1172700E+04    .2926100E+01   -.1329900E-02    .7435600E-06 
2,"CO2",44,2,0 
 0 0 0 0 
 0 0 0 0 



 
52 

 0 0 0 0 
 
The first four lines are header material that explains the file structure.   The next 8 lines are 
entries for water and carbon dioxide.  Each molecule has four lines associated with it.  The first 
line gives the molecule number, the molecule name (limited to four letters), the molecular 
weight, the symmetry number and the vibrational partition function at 296 K.  The last two 
entries require further explanation.  The symmetry number is two for linear molecules and three 
for nonlinear species.  The partition function sum is used only if measurements are made at 
temperatures significantly different than room temperature.  If this is not the case, then the final 
entry on line 1 should be zero and the next three lines should consist of 4 zeroes.   
 

On the other hand, if the temperature is far enough from room temperature that the 
vibrational distribution has changed significantly, then one must account for this in quantitative 
work.  In this case, the partition function at 296 K must be given on line one and lines 2 through 
4 should have parameters which describe a power series expansion of the partition function as a 
function of temperature.  The details of this expansion are given at the Hitran web site – 
www.hitran.com.  Also, expansion coefficients are provided in the Hitran database for many of 
the Hitran species.  The default molecular file created by TDLWintel provides the appropriate 
coefficients for water as an example.  All other species are listed without the partition function 
parameterization. 
 
  To modify the molecular file, simply edit it using Notepad are some other text editor.  
Again, make sure that you save the file in text format.   
 
Configuration File 
  Configuration files are used to store the startup conditions and preferences for 
TDLWintel.  There is only one configuration file and its name is always “tdl.con”.  Tdl.con must 
reside in the working directory, that is, the folder that TDLWintel is started from.  If TDLWintel 
is started without a configuration file, TDLWintel will create a basic configuration file which can 
be used to start the program.  However, the program will startup with default parameters which 
may not be appropriate to your system.  The default parameters should be inspected before using 
them.   
 

The configuration file contains a header section with general system parameters followed 
by four spectral files – one for each field.  Each spectral file contains a complete set of menu 
parameters in addition to the spectral information.  It is not usually necessary to edit the menu 
information since it can be modified from within TDLWintel.  However, the header material that 
precedes the spectral files must be edited directly in the “tdl.con” file if it needs to be changed.  
This header data does not change often.   The header information includes things like the title bar 
for the program, the number of lasers controlled, the indexes for addressing the data acquisition 
boards and the serial port specifications.   

 
The configuration file (and the spectral files) are self-documenting.  Each entry is 

actually a two or more lines with the first line being a description of the parameter or parameters 
which appear on the following line or lines.  If the configuration file needs to be directly 
modified, it can be edited as long as the basic structure of the file is not changed.  However, this 
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file is typically edited very infrequently.  It usually requires editing when the software is first 
installed and seldom afterwards. 
 
Spectral Files 
 There are two types of spectral files: individual ASCII spectral files with file extension 
spe and binary spectral archives with file extension spb.  Individual spectra may be saved to the 
hard disk in spe format at any time by the user. When saved, they are written to the default data 
directory.   When spectra are saved automatically (using the Auto Spectral Save method), they 
are saved as binary spectral archives and typically they are save in special folders whose name is 
the current date.   
 
 The spe files contain much more than the spectrum itself.  They contain most of the menu 
parameter settings that existed at the time the spectrum was acquired.  The spe file also contains 
waveforms that represent the result of the fit to the spectrum, the baseline determined from the 
fit, the laser tuning rate and the fitmarkers used in the fit.  Because they contain all this 
information and because they are ASCII files, the spe files are rather large. 
 
 The spb spectral archives are designed to hold the crucial spectral data in a compact 
format.  Typically, these files are binary archives that hold all the spectra recorded within a given 
hour.  The spb files do not contain the menu parmeters or the fitmarkers or the tuning rate or the 
fit waveforms.   They do contain some additional information beyond the spectra such as the 
pressure and temperature measured when each spectrum was acquired.  Because the spb files are 
incomplete, reanalysis of data requires that each spb file be accompanied by a matching spe file 
that contains the appropriate parameters needed to reanalyze the spectra held in the spb files.  
These parameters include the laser tuning rate, the spectral fitting parameters and the fit markers. 
 

The file names for both spe and spb files are encoded with the year, date, hour, minute 
and second that the file was opened.  This is true for stream files as well as spectral files.  If a 
spectral file were saved at noon time on the 25th of December 1996, its file name would be: 
961225_120000_1.spe or 961225_120000_1.spb if it was a binary archive.  If a stream file were 
opened at that time, its name would be 961225_120000.str. 

 
Reading Spectral Files 
 Since the spe files are ASCII, they can be opened with a wide variety of programs (Word, 
Wordpad, Excel, etc…).  Their format is relatively self-explanatory from notes within the file.  
However, Aerodyne provides an Igor IPG (under Macros in Igor) that will automatically load spe 
files and plot them.  We encourage you to use this tool. 
 
 Since the spb files are binary, it is more difficult to examine them or to load them into 
analysis programs.  They can be opened by TDLWintel using its Playback feature (discussed 
above in Section 10).  We provide the format of the spb files here for those that would like to 
open spb archives outside of TDLWintel. 
 

Every entry in the spb file is REAL*8.  The file starts out with a global header.  This is 
followed by an integral number of spectral records; each spectral record starts with a Spectral 
Header which is followed by the spectrum itself.  The format for the two types of headers is: 
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Global Header: 
 
GlobalHeaderLength   ‘number of entries in global header 
SpectralHeaderLength  ‘number of entries in spectral header 
SpectrumLength         'number of points in spectrum - includes all lasers and shutoff 
nSpeciesUsed            'number of molecules being fit 
nLasersUsed              'number of lasers in instrument 
 
For i = 1 To nLasersUsed 
  nChansV(i)                'number of points for each laser 
Next i 
 
For i = 1 To SpectrumLength 
  FreqWaves(i)             'tuning rate 
Next i 
 
For i = 1 To SpectrumLength 
  FitMarks(i)                 'fitmarkers 
Next i 
 
PathLengthSample 
PathLengthReference 
 
For i = 1 To nSpeciesUsed 
  ReferenceMR(i)     'reference mixing ratios  
Next i 
 
So the length of the global header (number of values) = 8 + nlasersUsed + nspeciesUsed + 2 * 
SpectrumLength 
 
 
Spectral Header: 
 
TimeStamp 
Duration 
PressureSample 
TemperatureSample 
PressureReference 
TempReference 
 
For i = 1 To nSpeciesUsed 
  FitPos(i)    'peak Positions 
Next i 
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For i = 1 To nLasersUsed 
  LaserWidth(i)     'laser linewidths 
Next i 
 
So the length of the Spectral Header = 6 + nlasersUsed + nSpeciesUsed 
 
And, of course, the length of the spectrum which follows the Spectral Header is 
SpectrumLength. 
 
 
Stream Files (STR and STC) 
 The stream files are ASCII output files that record the mixing ratios (STR files) and 
various housekeeping variables (STC files) as a function of time.  The STR file records mixing 
ratios as a function of time.  The format of the STR file name is based on the date and time as 
described in the preceding section, with “.str” as the file extension.  The STR stream files begin 
with a one line header which defines the time that the stream file was opened.  This time is given 
in four separate formats.  First local time is presented as a simple time stamp – date stamp 
combination.  The second representation is local time given as the number of seconds since the 
preceding midnight.  The third version of the initial local time is the Igor time – that is the 
number of seconds since January 1, 1904.  The fourth item in the header is the UTC time.  This 
is followed by a string that contains labels for the various species being measured. 
 
 
 

The remainder of the file consists of single line data entries with the format: 
 
Time (s), mixing ratio 1[, mixing ratio 2[, mixing ratio 3[, mixing ratio 4]]] …. 
 
Depending on the number of species in the fit, one to sixteen mixing ratios will be given 

after the time stamp.  The time stamp is given in units of seconds since January 1, 1904 – that is 
IGOR time.  The mixing ratios are presented in units of ppbv. 

 
The STC file contains a wide variety of housekeeping variables.  STC is a mnemonic for 

“stream conditions”.  The file name is identical to the corresponding STR file except that the file 
extension is “.stc”.  The format is similar to the STR file.  In this case there are two header lines.  
The first is identical to the STR file header.  The second header line contains labels for each of 
the housekeeping variables that are reported in the file.  After the two header lines, there is one 
line for each data point that is reported.  The line begins with the Igor timestamp and is followed 
by the housekeeping variables.   

 
The STC variables vary with instrument type.  The meanings of various common STC 

header labels are as follows: 
 
Range_F1_L1; Signal range for laser 1 field 1  
Range_F2_L1; Signal range for laser 1 field 2   
Praw; Gas pressure at sample cell    With no averaging. 
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Traw; Gas temperature at sample cell   With no averaging. 
Pref; Gas pressure at reference cell if there is a second cell  
Tref; Secondary temperature measurement. 
StatusW; The status word contains the valve status and many other flags.  Details of format are 
provided below. 
USBByte   Obsolete. 
NI6024Byte  Obsolete. 
SPEFile;   Sometimes there will be the name of a spectral file saved with the same time stamp.   
T_Laser_1; Temperature for laser1    
V_Laser_1;  The laser current for laser 1 appears here for CW lasers. 
LW_Laser_1;  Linewidth of laser 1.    
T_Laser_2; Temperature for laser 2    
V_Laser_2;  The laser current for laser 2 appears here for CW lasers. 
LW_Laser_2;  Linewidth of laser 2.    
X1;  This is the chi squared value (goodness of fit parameter) returned from fit #1. 
pos1;  Actual position (in channels) for first species of first fit. 
X2;    Chi squared from fit #2. 
pos2;  Actual position for first species of second fit. 
X3;   Chi squared from fit #3. 
pos3;  Actual position for first species of third fit. 
dT1;   Size of temperature correction applied to laser #1. 
dT2;  Size of temp correction applied to laser #2. 
  
 
Status Word Format: 
If the bit is set to 1, it means that the function is true or activated. 
 
'First byte 
Bit 1  AutoBG  
Bit 2  AutoCal  
Bit 3  Frequency Lock  
Bit 4   Binomial Filter  
Bit 5   Alt Mode  
Bit 6   GuessLast  
Bit 7    PowerNorm  
Bit 8    Continuous Reference Lock 
 
'Second byte 
Bit 1  Auto Spectral Save 
Bit 2  PressureLock  
Bit 3  reserved 
Bit 4  reserved 
Bit 5  Write Data 
Bit 6  RS232  
Bit 7  Electronic BG Subtraction 
Bit 8  reserved 
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'Third byte 
Bit 1       Valve #1 (CAL) active 
Bit 2      Valve #2 (BG) active 
Bit 3      Valve #3 active 
Bit 4      Valve #4 active 
Bit 5      Valve #5 active 
Bit 6       Valve #6 active 
Bit 7       Valve #7 active 
Bit 8       Valve #8 active 
 
'Fourth byte 
Status of valves 9 to 16 if applicable 

 
 
Digital Output Format 
 The digital output port can be used to transmit mixing ratios and time stamps to another 
computer or to a data logger.  There are three available formats.  Each digital format gives a time 
stamp in seconds and mixing ratios in ppbv.  The original format has some peculiarities in order 
to maintain compatibility with earlier versions of TDLWintel. 
 

Let’s begin by describing the original format.  In the original format the time stamp is 
defined as the time since TDLWintel was started.  If one or two mixing ratios are being 
determined, the output is provided as a single line terminated with a CR+LF.  However, if three 
or four mixing ratios are being determined, the output is provided as two data lines with the same 
timestamp.  Concrete examples will make this clearer. 
 
 For a one species fit the digital output looks like this: 
 
t=   23.089 m= 1.234E+03  M=-99.990E+00<CR><LF> 
 
The –99.99 entry indicates that this species was not fit. 
 
 For a two species fit the digital output looks like this: 
 
t=   23.089 m= 1.234E+03  M= 2.356E+01<CR><LF> 
 
 
 For a three species fit the digital output looks like this: 
 
t=   23.089 m= 1.234E+03  M= 2.356E+01<CR><LF> 
t=   23.089 m= 5.664E+03  M=-99.990E+00<CR><LF> 
 
 For a four species fit the digital output looks like this: 
 
t=   23.089 m= 1.234E+03  M= 2.356E+01<CR><LF> 
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t=   23.089 m= 5.664E+03  M= 7.888E+04<CR><LF> 
 
 The newer formats are simpler and are better adapted to reporting multiple 
concentrations.  Each of these is a single line format and is comma delimited.  There are 8 
commas which separate 9 fields for the more compact format and 16 commas that separate 17 
fields for the more expansive format.  In most cases, the more compact format is preferred. 
 

For the compact format, the nine fields consist of the timestamp (in seconds) followed by 
8 mixing ratios (in ppbv).  The timestamp is given as an Igor time – that is the number of 
seconds since January 1, 1904.  If a mixing ratio is not calculated, its field is left blank.  The first 
character in the line is the letter “a” which is used to indicate the start of the line and the format.  
Again, the line is terminated with a carriage return-line feed.  Hence, for a single species fit, a 
data line would look like: 
 
a3132321365.000, 1.398e+00,,,,,,,<CR><LF> 
 
The Igor time stamp corresponds to April 4th, 2003 at 5:16:05 PM.  If four species are being fit, 
we might have: 
 
a3132321365.000, 1.398e+00, 9.2345e+03,-3.4589e+01, 2.3891e-02,,,,<CR><LF> 
 
 
 
 

Appendix C:  TDLWintel External Command Protocol 
 
 TDLWintel has a simple communication protocol which allows it to accept commands 
from other processes.  The current version of the protocol is based on information transfer using 
files.  Commands are appended to a command file by the external process or processes.  
TDLWintel reads this file approximately once every second and acts on the commands.   
TDLWintel can write an acknowledgement file after it executes each command, if desired.  
TDLWintel does not provide any other feedback  to the external process at this time.  However, 
later versions of the protocol will likely support bi-directional information exchange.  We first 
discuss the file structure and file handling.  The command syntax is presented in the final section. 
 
File Structure and File Handling 

TDLWintel maintains a “Commands” folder which is a subfolder of the folder that 
TDLWintel is launched from.  This is the location for creating the files that TDLWintel responds 
to.  Processes which run on a separate computer can interact with TDLWintel only if they have 
write privileges for the “Commands” subfolder.  The primary command file is named 
“ComQue.xyz”.  The file format is ASCII.  Each line of the file contains a single command.  The 
first line is the first command and the last line is the final command.  Therefore, when processes 
add commands to the file, they should open ComQue.xyz for append and they should append the 
new command to the bottom of the file.  The syntax of the individual command lines is discussed 
below. 
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 Since TDLWintel periodically reads the command queue file, the external process must 
be prepared to deal with the possibility that the command queue file may be locked.  TDLWintel 
locks the file only for a very brief time (typically less than 10 ms), so it should be easy for the 
external process to wait for the lock to be released. 

 
If requested, TDLWintel will send an acknowledgement to the external process after it 

executes each command.  This acknowledgement is sent by creating an empty file in the 
“Commands” subfolder.  The name of the file specifies the command that is being 
acknowledged.  The name is handle.xyz where handle is a unique string originally generated by 
the external process (see below).  It is the responsibility of the external process to delete any 
acknowledgment files that are created in response to its commands. 
 
Command Syntax 
 Each command line consists of three parts: a unique handle (created by the external 
process), an acknowledgement plan, and a command string.  These are delimited by two 
commas: 
 
 handle, plan, command 
 
In this scheme, handle is a unique string identifying this particular command line.  We 
recommend using the current Igor time with millisecond resolution although this is not required 
at this time.  The Igor time is the number of seconds since January 1, 1904.  The variable, plan, 
is either “ACK” or “NAK” depending on whether the external process requests or does not 
request an acknowledgment to be generated.  Finally, command is the actual command string.  
The syntax of the command string is as follows (as of TDLWintel Rev. 11.02): 
 
"ab" = Quit TDLWintel 
"ac" = Resynchronize the TDLWintel millisecond clock to the local time of day clock 
"ad"dstring = Synchronize the time of day clock on the tdlwintel computer to time of day clock 
on another computer with network address dstring 
"ae"dstring = Change data folder to dstring 
"af" = Go to stream mode 
"ah"dstring = Switch to field number dstring 
"ai" = Go to display mode 
"aj" = Go to current signal mode 
"ak" = Go to signal average mode 
"al" = Go to burst mode 
"amwd” = Toggle write disk 
"amwd0” = Deactivate write disk 
"amwd1” = Activate write disk 
"amass” = Toggle automatic spectral save 
"amass0” = Deactivate automatic spectral save 
"amass1” = Activate automatic spectral save 
“ampnorm” = Toggle pulse normalization 
“ampnorm0” = Deactivate pulse normalization 
“ampnorm1” = Activate pulse normalization 
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“amabg” = Toggle automatic background 
“amabg0” = Deactivate automatic background 
“amabg1” = Activate automatic background 
“amrlock” = Toggle frequency lock 
“amrlock0” = Deactivate frequency lock 
“amrlock1” = Activate frequency lock 
“amebg” = Toggle electronic background 
“amebg0” = Deactivate electronic background 
“amebg1” = Activate electronic background 
“ant”dstring = Toggle valve # dstring (valve #’s are zero based: first valve is 0) 
“anc”dstring = Close valve # dstring  (valve #’s are zero based: first valve is 0)  
“apon”dstring = Turn on the “fix baseline to 1000” feature in Field # dstring 
“apoff”dstring = Turn off the “fix baseline to 1000” feature in Field # dstring 
"aq" = Initiate background measurement – ABG must be active 
"ar" = Initiate calibration gas measurement – CAL must be active 
"as" = Go to Playback mode 
 
An example of several command lines is: 
 
3201178406.518, NAK, amwd  ‘toggle write disk 
3201178407.777, NAK, ah3   ‘switch to field 3 
3201178408.779, NAK, amass  ‘toggle auto spectral save 
3201178410.335, NAK, aj   ‘goto current signal 
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Appendix D:  TDLWintel Alternative Hardware Protocol  
 
 TDLWintel has the ability to monitor and, in some cases, to control several key 
instrument parameters using specific hardware interfaces.  These parameters include sample 
pressure, sample temperature, QC laser voltage and QC laser temperature.  The hardware used 
by TDLWintel involves a combination of NI data acquisition boards and PMD1208 USB data 
acquisition modules.  This convention restricts users to employing only the hardware supported 
by TDLWintel to monitor and control these parameters.  In order to provide more flexibility, 
TDLWintel has been extended to allow a more general solution. 
 
 As of version 10 of TDLWintel, the program now supports a simple command language 
which allows it to import and export information regarding the parameters under discussion.  
This command language is similar though not identical to the language that TDLWintel supports 
for processing general external commands.  The basic idea is the following.  If TDLWintel 
wishes to adjust the temperature of the laser, rather than doing so directly by controlling a DAC, 
it does so indirectly by writing a line in a file.  Another program (provided by the user) reads the 
line in the file and implements the temperature adjustment with the hardware which it supports.  
In this way, any hardware can be used and TDLWintel has no knowledge of the details of that 
hardware.   
 
 This is accomplished with a simple communication protocol which allows TDLWintel to 
send and receive data from other processes.  The current version of the protocol is based on 
information transfer using files.  TDLWintel checks for incoming information (sample 
temperature, sample pressure, laser temperature or laser voltage) approximately once every 
second.  TDLWintel exports set points for the laser temperature and voltage whenever these are 
changed (either by the user or by TDLWintel itself).   We first discuss the file structure and file 
handling.  The command syntax is presented afterwards. 
 
File Structure and File Handling 

TDLWintel maintains a “Commands” folder which is a subfolder of the folder that 
TDLWintel is launched from.  This is the location for creating the files that TDLWintel uses to 
support alternative hardware.  There are two files of interest: SetQue.xyz and GetQue.xyz.  
TDLWintel will import data from sensors if that data is written into GetQue.  When TDLWintel 
wants to change the value of a laser temperature or voltage, it will write that request into SetQue.  
The file formats are ASCII.  Each line of the files contains a single command or piece of 
information.  The first line is the first command and the last line is the final command.  
Therefore, when processes add commands or information to the file, they should open 
GetQue.xyz for append and they should append the new reading to the bottom of the file.  The 
syntax of the individual command lines is discussed below.  Correspondingly, the external 
process which is responsible for controlling the hardware, should check for the existence of a 
SetQue file frequently – approximately once per second.  When such a file is found, the external 
process should destroy it by renaming it.  The external process should then open the renamed file 
and process its commands sequentially. 
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 Since TDLWintel also periodically accesses these files, the external process must be 
prepared to deal with the possibility that the files may be locked.  TDLWintel locks the file only 
for a very brief time (typically less than 10 ms), so it should be easy for the external process to 
wait for the lock to be released. 
 
Command Syntax 
 Each command line consists of two parts: a hardware identifier and a value.  These are 
delimited by one comma: 
 
 id, value 
 
In this scheme, id has the following values: 
 
ID  Meaning 
P  Sample Pressure (Torr) 
T  Sample Temperature (K) 
LVn  Laser Voltage (n=1-4) (V) 
LTn  Laser Temperature (n=1-4) (C) 
 
These IDs are not case sensitive.  Any of these IDs can be used to send data to TDLWintel 
through the GetQue.  However, P and T cannot be used in the SetQue, since TDLWintel does not 
support control of the sample pressure or temperature at this time. The laser numbers are 
sequential beginning with one. 

 
An example of several lines from GetQue is: 

 
P,10.31  ‘sample pressure is 10.31 Torr 
T,297.1  ‘sample temperature is 297.1 Kelvin 
Lv1,10.0  ‘Laser #0 (or first laser) voltage is 10.0 Volts 
lT2,-22.3  ‘Laser #2 (or second laser) temperature is -22.3 Celsius 
 
The syntax for SetQue is analogous. 
 
Configuring TDLWintel 
 TDLWintel has six separate parameters which allow partial or complete implementation 
of this alternative hardware protocol.  It is possible to separately enable or disable 1) reading 
sample pressure, 2) reading sample temperature, 3) reading the laser voltages, 4) reading the 
laser temperatures, 5) setting the laser voltages and 6) setting the  
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laser temperatures.  These six processes are controlled by Boolean parameters in the tdl.con file.  
The Boolean parameters are false by default which disables the alternative hardware interface.   
 

The parameters are labeled as follows:   
 
"P external?" 
"T external?" 
"LaserV get external?" 
"LaserT get external?" 
"LaserV set external?" 
"LaserT set external?" 
 
Setting any of these parameters to true, activates the alternative interface and deactivates the 
standard interface for controlling or monitoring the parameter. 
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Appendix E: DEFT Protocol 
 

The DEFT protocol is a procedure for sharing data between two programs.  This method 
was developed at Aerodyne Research and is implemented in several Aerodyne computer 
programs including TDLWintel.  DEFT stands for Data Exchange by File Transfer.  Its purpose 
is to share real time data between a data acquisition program (source program or DEFT writer) 
and a data analysis or display program (destination program or DEFT reader). 

 
The source program writes its data (usually time stamps and concentrations) to a file that 

exists on its local computer network.  This file will grow in size as each new data line is written 
to it by the source program.  When the destination program is ready for new data it reads the 
DEFT data file and destroys it.  Hence the DEFT file is transient.  The DEFT method does not 
provide long term data storage.   

 
To collect the transient data, the DEFT reader checks for the existence of the DEFT file.  

If the file exists then the reader attempts to rename it. The renaming either succeeds or fails 
depending on whether or not source program is currently writing to the DEFT file.  If the reader 
fails, it should just wait and then try again.  We have found the Windows “Rename” command to 
be the fastest way to access the data and minimize collisions.  Note that two goals are 
accomplished when the destination program renames the DEFT data file before opening it with 
the new name:  
 

1) The DEFT reader gets access to all previously unread data and,  
2) The original DEFT file is destroyed so that it does not grow too large and so that old 
data is automatically erased.  

 
Our testing has shown that this method is robust and complete. Collisions between the 

DEFT writer and the DEFT reader trying to harvest the data have not crashed either computer. 
 
If the DEFT reader program is not running, then the DEFT file will grow in size.  If it 

gets too large, then the DEFT writer should delete it and start over.  The folder that holds the 
DEFT file is called the transient folder.  This folder must be accessible to both computers.  It is 
ideal to choose the transient folder to reside on a RAM disk.  This minimizes the possibility of 
collisions between the DEFT writer and the DEFT reader. 

 
TDLWintel is equipped to be a DEFT writer.  This option is configured under the 

Edit\Write Data menu of TDLWintel by selecting the option to “Write Transient Files.”  When it 
is implemented, TDLWintel writes the DEFT file to a folder that is called the Transient folder.  
This folder and the DEFT file name are each selected under this Write Data menu.  
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Appendix F: Dual Pressure Control System for CO2 Isotope Instruments 
 

 
Introduction 
 This document explains the operation of the pressure control system in the Aerodyne 
isotope instrument.  The isotope instrument has two multipass cells and the pressure in both cells 
is under computer control.  The layout of the flow control system is shown in the above figure 
under normal operation conditions.   We begin by discussing the reference cell. 
 

The reference cell receives its gas flow from a reference cylinder (not shown).  The 
pressure in the cell is controlled by a flow controller that is referenced to the absolute baratron.  
Typically, we choose the set point for the flow controller as approximately 50 Torr.  There is a 
throttle valve on the output side of the reference cell.  By adjusting the throttle valve, the flow 
rate can be set.  The flow rate is not precisely controlled but should be set to a low value to 
conserve reference gas.  We usually adjust the flow rate to be approximately 50 sccm.  Under 
these conditions, the residence time in the reference cell is: 

 
t(s) = (V/F)*(P/760)*60 = (300/50)*(50/760)*60 = 24 s 

 
The reference flow controller has a range of 0 to 500 sccm. 
 
 The sample cell receives its gas flow from the atmosphere, from a prepared sample or 

 

 
 
Figure F1.  Pressure Control Layout with Differential Baratron controlling Sample flow. 
 



 
66 

from a calibration cylinder.  The pressure in the cell is controlled by a flow controller that is 
referenced to the differential baratron.  The differential baratron measures the pressure difference 
between the sample cell and the reference cell.  The set point for the differential baratron is zero 
Torr.  Since the reference cell is locked at 50 Torr (using the absolute baratron), the sample cell 
is also held at this pressure.  By using a differential baratron we can measure the pressure 
difference between the cells with great precision – typically 1 mTorr.  Under normal operation 
we find that the differential pressure can be controlled with an accuracy of +/- 10 mTorr over 
long time periods (days).  An error of 10 mTorr out of 50 Torr produces a fractional error of 2 x 
10-4 in the pressure ratio between the cell.  There is a throttle valve on the output side of the 
sample cell.  Again, by adjusting the throttle valve, the sample flow rate can be set.    We usually 
adjust the flow rate to be approximately 1000 sccm.  Under these conditions, the residence time 
in the sample cell is about 1.2 seconds.  The sample flow controller has a range of 0 to 10,000 
sccm. 
 
 The pressure readings from the two 
pressure sensors are displayed in the Status 
Report which is opened by clicking on 
Windows\Status Report.  The pressure reading 
for the absolute baratron is under the AD0 
heading.  The pressure reading for the 
differential baratron is under the AD2 
heading.  A screen shot is shown in Figure 
2.  The pressure displayed in the Status frame (at the bottom of the main TDLWintel window) is 
the Sample pressure which is the sum of AD0 and AD2. 
 
Quick Start of Pressure Lock 
 It is very easy to get started with the pressure control.  Simply click on the toggle button 
labeled “PL” for pressure lock.  This is shown in Figure 3.  Clicking on PL activates the pressure 
lock procedure.  The program automatically uses the absolute 
baratron to monitor the pressure in each of the cells and adjusts 
the corresponding flow controllers to move the pressures 
near the set points.  When this has been accomplished, the 
program will enable the differential baratron and will begin 
actively locking both flow controllers in the 
configuration shown in Figure 1.  If all of the control valve 
lock parameters are correct, then clicking on PL is the only 
action required to turn on the lock.  Even if the 
parameters are not perfect, clicking on PL should bring the 
control valves close to their respective lock points.  The pressure 
lock is turned off by clicking on PL.  The pressure lock also turns itself off if the differential 
pressure sensor measures a pressure difference that is too large. 
 
 The following sections give a more detailed description of the pressure control system 
and the control valve lock parameters. 
 
 

 
Figure F3.  Toggle buttons.  
Pressure lock is activated 
with “PL” button.  

 
Figure F2.  Slow AD readings.  AD0 is pressure 
from absolute sensor.  AD2 is pressure from 
differential sensor. 
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Setting the Flow Controller Parameters 
 The flow controllers are controlled by the TDLWintel computer program.  TDLWintel 
uses simple proportional control to hold the absolute and differential baratrons at their set points.   
The program monitors the pressure readings approximately 5 times per second and makes flow 
corrections when necessary and as determined by the control parameters for each cell.  The 
control parameters can be viewed and adjusted in TDLWintel under Command\Control Inlet 
Valve.  The menu is shown in Figure 4.  There is one tab for the reference cell (on the top) and 
one for the sample cell (on the bottom). 
  

In the top left corner of the menu, there is a frame labeled Adjust Valve.  The control 
voltage applied to the flow controller is displayed here.  The operator can change this control 

voltage by typing a new voltage in the textbox and then clicking Change Set Point.  This is 
useful during setup.  But during normal operation the control voltage will be determined by 
TDLWintel. 
  

There are six lock parameters for each control valve.  The Set Point is the desired 
operating pressure.  This should be 50 Torr for the absolute baratron (reference cell) and 0 Torr 
for the differential baratron (sample cell).  The Range parameter is used to decide whether or not 
to make a correction.  If the pressure error is smaller than the range, then no correction is made.  

 
 
Figure F4.  Control Valve menu. 
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We have gotten good results by selecting 0.050 Torr for the reference cell and 0.005 Torr for the 
sample cell.  The Correction parameter is used modify the size of the correction that is applied to 
the flow controller.  When it is set to 100%, the program applies the correction that is expected to 
return the pressure exactly to its set point.  When it is set to 50% the program only applies one 
half of the full correction.   We have obtained good results by choosing 70% for the reference 
cell and 50% for the sample cell.  The problem with choosing 100% is that it may lead to 
oscillations in the control circuit.   As with most control loops, overly aggressive control 
increases the possibility of oscillations.  The Tau parameter is the time constant for the control 
circuit.  After a flow correction is made, the program will wait for at least Tau seconds before 
making another flow correction.  This delay is important since it takes time for the cell pressure 
to respond to changes in the control valve set point.  Because of the slow flow into the reference 
cell, this response time is quite long – 24 seconds.  We recommend setting Tau to 10 seconds for 
the reference cell and 2 seconds for the sample cell.  Shorter times are more aggressive.   This 
means that shorter times lead to tighter control but also may cause oscillation – so they cannot be 
too short.   The dV/dP > 0? parameter is not currently used.  It should be set to True for both 
valves.  Finally, the dV/dP parameter is perhaps the most important.  It is the derivative of the 
control voltage with respect to the pressure at the set point pressure.  This parameter allows the 
program to calculate the size of the correction that must be sent to the control valve to adjust the 
pressure properly.  These parameters depend on flow rate and pressure and can be measured by 
the program using the Measure Derivative button in the menu.  This will only give the correct 
result if the pressure in the cell is near its set point.  So it is important to set the pressure first.  
This can be done manually using the Change Set Point button or automatically (by the computer) 
using the Search for Lock Point button.  The next section discusses this procedure. 

 
Adjusting the Pressure to Near the Lock Point 
 There are two phases to locking the sample cell pressures.  First, both valves should be 
adjusted so that the cell pressures are near the set point – say within 1 Torr.  In the second phase, 
the lock is activated.  The first phase is complicated by the fact that the differential pressure 
gauge only has a range of approximately +/- 3 Torr.  If the difference between the pressures in 
the two cells is larger than 3 Torr, we cannot use the differential pressure sensor.  In fact, there is 
a solenoid valve that opens to protect the differential baratron when the magnitude of its reading 
exceeds 3 Torr.  When this “protection” valve opens, the differential baratron reports zero Torr 
regardless of the pressure difference between the cells.   Hence, the initial setting of the pressure 
in the sample cell must be accomplished without the use of the differential baratron. 
 

Our solution is to employ a solenoid valve to allow us to connect the absolute baratron to 
either the reference cell (normal arrangement shown in Figure 1) or the sample cell.  With this 
approach we can set the pressures in both cells to be near 50 Torr using the same absolute 
baratron.  The solenoid valve that connects the absolute baratron to the cells can be controlled 
under the Command\Operate Valves and Switches menu.  This menu is shown in Figure 5.   
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Valve #5 is used to control the direction of the Absolute Baratron.  When the valve is 
activated (as shown in the figure), the box is colored red and the absolute baratron is connected 
to the reference cell (red = ref).  When the valve is deactivated or closed, the box turns white and 
the absolute baratron is connected to 
the sample cell.  Similarly, Valve #6 
is used to protect the Differential 
Baratron.  When it is inactive or 
closed (as shown) the differential 
baratron is protected and will always 
read zero Torr.  When it is activated, 
the box will turn read and it will 
report the pressure difference 
between the cells.  As we mentioned 
above, this valve will be 
automatically deactivated whenever 
the pressure difference exceeds 3 
Torr in magnitude.   
 
 There are two ways to adjust 
the cell pressures near their set 
points.  The first approach is to do it 
manually.  In this approach, the user 
adjusts the control valve set point 
(Figure 4) until the pressure in each 
cell is nearly correct.  The user must 
switch solenoid valve #5 in order to 
measure the pressure in each cell.  
This approach is tedious.  The second approach is easier since the computer does the job 
automatically.  
 

 Simply click on the toggle button labeled “PL” for pressure lock.  This is shown in 
Figure 2.  As we discussed above, clicking on PL activates the pressure lock procedure.  The 
program automatically uses the absolute baratron to monitor the pressure in each of the cells and 
adjusts the corresponding flow controllers to move the pressures near the set points.  When this 
has been accomplished, the program will enable the differential baratron (with solenoid valve #6) 
and will begin actively locking both flow controllers in the configuration shown in Figure 1.  If 
all of the control valve lock parameters (Figure 4) are correct, then clicking on PL is the only 
action required to turn on the lock.  If the lock is noisy, then it is likely that some of the 
parameters need to be adjusted.  The parameter that is most likely to need adjustment is dV/dP, 
the control voltage derivative with respect to pressure.   

 
There are also two approaches to determining the derivatives – a manual approach and an 

automated approach.  To do the manual method, simply turn off the lock by clicking on PL.  
Even though the lock is off, the cell pressures should still be near their set points.   Now vary the 
control voltage for each valve slightly using the “Select  Control Voltage” text box.  A 
reasonably change in voltage might be 0.1 Volts.  Note the change in the pressure reported on the 

 
Figure F5.  Solenoid valve menu. 
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absolute baratron and use this to calculate the derivative.  Make sure that you remember to adjust 
the solenoid valve to the proper state to measure the derivative for each control valve.  Also, be 
sure to measure these derivatives near their expected control points (typically near 50 Torr).  
 

The automatic approach can be activated when the pressure lock is turned on by right 
clicking on PL rather than left clicking.  In this case the program will measure the derivatives 
while it is finding the desired lock point.  It will take some time to measure the derivatives so it 
is probably best to use the right click option once to set the derivatives and to use the left click 
activation normally. 

 
In the next two sections, we document the configuration file parameters that control the 

operation of the pressure lock software. 
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Note 1 – TDLWintel Pressure Control Configuration Parameters for Normal Operation 
 

TDLWintel supports pressure control of matched cells with the differential baratron used 
to control sample flow (as shown above in Figure 1) or with the differential baratron used to 
control the reference flow (shown below in Note 2).  Although both configurations are 
supported, only the first configuration has been used to date. 
 
In both configurations: 
 
The absolute baratron is always connected to AD0. 
The differential baratron is always connected to AD2. 
 
In the standard configuration shown above: 
 

Preference = Pabsolute 
Psample = Pabsolute + Pdifferential 

 
Mandatory TDLWintel configuration file parameters: 
"pref is dP?" 
#FALSE# 
pSamp is deltaP 
#TRUE# 
pControlAbs? 
#TRUE# 
pControlDiff? 
#TRUE# 
"read AD2?" 
1 
 
Other related TDLWintel configuration parameters that must be set properly and may take on 
various values: 
 
Valve DiffBara 
5 
Valve SampleBara 
4 
Valve SampleBara is Sample Normal? 
#FALSE# 
pControlAbs DAC 
4 
pControlDiff DAC 
5 
"pRef at 0" 
0 
"pRef at 1" 
1 
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Note 2 – TDLWintel Pressure Control Configuration Parameters for Reversed Operation 
 
The alternative configuration for flow control uses the differential baratron to control the 
reference flow.  In this case, two configuration file parameters must be changed: 
 
"pref is dP?" 
#TRUE# 
pSamp is deltaP 
#FALSE# 
 
In this configuration the cell pressure readings are defined as: 
 

Psample = Pabsolute 
Preference = Pabsolute + Pdifferential 

 
The layout for this configuration is shown below: 
 
 

!

Pressure&Control&Layout&with&Differential&Baratron&controlling&Reference&flow:&

&

Absolute 
Baratron
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Reference
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To Pump To Pump &

 
 
Figure F6.  Alternative pressure Control Layout with Differential Baratron controlling 
Reference flow. 
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Appendix G:  Igor Procedure Files that Supplement TDLWintel 
 
There are several Igor Procedures that we have written to augment the operation of TDLWintel. 
The routines are accessed under the Igor Macro menu item.  Although there are more than a 
dozen choices there, the routines that are useful to most users are only 5 or 6 in number.  I will 
say a word or two about each of these: 
 
1)  Hitran Functions\Make Hit File - This routine is used to create the molecule specific hit files 
that TDLWintel uses.  Follow the numbers.  You will be providing the location of the Hitran by-
molecule PAR folder, the molecule number, the frequency range and the intensity threshhold. 
 
2)  Allan_Variance_Panel - This routine does Allan variance plots.  You provide the input 
concentration wave and the input timestamp wave.  There is an option to use cursors to analyze a 
subset of the wave. 
 
3)  Global Utils\Handy Graph Buttons - This routine will put "handy graph buttons" on whatever 
graph had the last focus.  This allows you to pan and zoom more easily. 
 
4)  Hitran Simulations - Initialize HitranIgor Panel -  This is the routine for creating spectral 
simulations.  You choose many parameters, but these are clearly laid out in the panel.  It is 
critical that you provide the path to the database - that is, the path to Hitran04.par.  The hitran 
name and the output name parameters are arbitrary.  The selection box in the lower left corner 
should be set to the default setting: "SEL + ATM Batch Run". 
 
5)  TDLWintel File Loader Functions\ STR Files Loader - This loads the TDLWintel files that 
hold the concentrations (.str files) and the conditions (.stc files).    Start by specifying the folder 
where the data is.  The box on the left will give a list of str files followed by a list of stc files.  
Select the str and stc files that you want to load by highlighting them.  There is also a data 
masking tab that allows you to filter the data by the state of the solenoid valves as recorded by 
TDLWintel in the stc file. 
 
6)  TDLWintel File Loader Functions\ Load_Browser_II - This loads TDLWintel spectral files 
(.spe).  It is not used much for data analysis but is sometimes used to make a nice spectral graph 
for papers and presentations. 
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Appendix H:  Step by Step Guide to Speeding Up Data Acquisition Rate 
 

Here is a list of things that you can do to speed up the fitting rate.   
 

1)  Use Guess Last.  This usually helps significantly.  Just click on GL under the toggle buttons. 
2)  Make your hit files as small as possible.  Do not include any unnecessary lines. 
3)  Make sure that no other applications are running on the computer unless they are absolutely 
necessary. 
4)  Make sure that the TDLWintel display is updating no faster than 1 Hz. 
5)  Close the spectral display window and the mixing ratio window (and all other windows) in 
TDLWintel. 
6)  Make sure that the frequency lock is set to semi-continuous with a 1 second time interval.   
7)  Use minimum fitting in Field 4 - one line in reference hit file, first order polynomial, fixed 
concentration, if possible. 
8)  If using RS, use the 56 k baud rate if you can.  Also, you could try using one of the more terse 
formats.  Right click on RS toggle to change these parameters. 
9)  Make sure that the computer clock rate is set to its maximum speed.  This can be checked in 
the BIOS for most computers. 
10)  If your computer has been running for several days, try rebooting it.   
11)  If you are writing data to a transient folder (e.g. for DacOut), make sure that 

the transient folder is on a RAM disk (r:\) not the hard drive (c:\). 
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Appendix I:  Calling TDLWintel from Another Program:  External Playback Feature 
 

TDLWintel can be called – essentially as a subroutine – from other programs that wish to 
take advantage of its spectral fitting features.  This External Playback feature allows spectral 
analysis to be customized beyond the options directly available within Internal Playback. 
 

The External Playback feature uses two files:  “PBExt.in” and “PBExt.out”.   The 
parameters within “PBExt.in” will set the playback parameters for the external playback to 
follow.   Here is how it is works.  You create a file called "PBExt.in" and place it in the 
TDLwintel Commands folder.  Then you launch TDLWintel.  TDLWintel starts up and notices 
that PBExt.in exists.  It reads the file (which contains playback parameters) and immediately 
deletes the file.  It also looks for PBExt.out.  If it exists, it is also deleted.  Then TDLWintel goes 
into playback mode.  It minimizes the spectral window to enhance speed (you can maximize the 
spectral window to observe). When Playback is complete, TDLwintel writes a new PBExt.out 
file to the commands folder.  Then TDLWintel terminates. 
 
PBExt.out contains the same parameters as PBExt.in.  So what is its purpose?  Two purposes: 
 
1) TDLWintel will create a PBExt.out file every time that you exit TDLWintel.  This provides a 
template for creating your PBExt.in files and a record of what TDLWintel thinks the playback 
parameters were. 

 
2) If you are running a series of calls to TDLWintel, you will want to know when TDLWintel 
has completed the latest playback run.  You can do this by polling for the existence of 
PBExt.out.  TDLWintel kills the file as soon as it enters external playback and recreates it when 
it terminates.  So when the file reappears, you know that TDLWintel has terminated and that 
your data is ready. 
 
One other note:  Every other line in PBExt.out is a comment line describing the parameter to 
follow.  This is for your information.  The PBExt.in file does not need to have the same 
comments.  It does need to have the every other line format, but the comment lines can be left 
blank or can have a default descriptor like "comment". 
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Appendix J  - Step by Step Guide to Measuring the Laser Tuning Rate 
  The measurement of the laser tuning rate is accomplished by inserting an etalon into one 
of the beam paths and then analyzing the resulting sinusoidal waveform to deduce the laser 
tuning rate at each point in the laser sweep.  The tuning rate function is determined using 
TDLWintel’s Get Tune Rate from Etalon utility (under the Command menu or ctrl-e) which 
automatically determines the tuning rate by analyzing a frequency scan acquired with an etalon 
inserted in the beam path.  See Figure. We typically use an etalon with a free spectral range of 
0.05 wavenumbers.   

 
 The step by step procedure is the following. 
 

1) Start by putting all fields in Dislplay Mode.  Then return to Field 1 if your instrument 
supports Power Normalization.  If not, go to whichever field is able to show the etalon 
spectrum. 

2) Put the program in Current Signal Mode. 
3) Toggle the PN button to activate the Power Normalization method (if supported). 

 
Figure J1.  Numerical analysis of etalon spectrum to determine laser tuning rate.  
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4) Toggle the DS/DT/DR button until it reads DS. 
5) Rescale the display so that you can see the entire spectrum.  This is accomplished by 

clicking on the Horizontal Full button and then the Vertical Frame button or with the 
quick keystrokes F1,r. 

6) We want the etalon spectrum to appear on a flat background with no significant 
absorption lines.  If you see absorption lines, then add background gas to the sample cell 
if feasible.  If it is not feasible to remove these lines, then you will need to perform an 
optional step later to remove them mathematically. 

7) Insert the etalon into the appropriate beam path.  The optimal location will vary with 
instrument.  With many recent Aerodyne instruments the etalon is installed on a 
motorized actuator and is inserted by activating one of the switches under the 
Command\Operate Valves and Switches menu. 

8) Acquire the etalon spectrum.  Do this by entering Signal Average mode for ~10 seconds 
and then exit to Display Mode.  This is your etalon spectrum.   

9) Remove the etalon. 
10) Optional steps.  If you were not able to remove all significant absorption lines in step 6 or 

if you are not using Power Normalization, then you need to acquire a normalization 
spectrum and analyze the ratio of your etalon spectrum and your normalization spectrum.  
Proceed as follows: 

a. Transfer the etalon spectrum into Field 3 using the menu item Command\Transfer 
Field Parameters. 

b. Remaining in your current Field, return the program to Current Signal mode. 
c. Acquire the normalization spectrum.  Enter Signal Average mode for ~10 seconds 

and then exit to Display Mode.  This is your normalization spectrum 
d. Divide the two spectra.  Use the spectral math utility under 

Command\Ratio,Subtract,Add.  Choose the divisision option “/”.  If you are in 
Field 1 then choose Field 1 = Field 3 / Field 1.  If you are in Field 2 then choose 
Field 2 = Field 3 / Field 2. 

e. The result should appear in your current field.  This is the normalized etalon 
spectrum. 

11)   Now it is time to analyze etalon spectrum.  Begin by adding two “N” fitmarkers to the 
spectrum that bracket the region that you want to analyze.  Typically the beginning and 
end of the spectrum do not have well defined etalon peaks and should not be analyzed.  
See the figure above for an example of proper fit marker placement. 

12)   Filter the spectrum.  Typically it is helpful to smooth the spectrum using the binomial 
Filter method.  Do this by right clicking the F1 toggle.  With each click the filter order 
will increase and the smoothing will increase.  Typically F5 or F7 is adequate.  Too much 
smoothing will distort the tuning rate. 

13)   Execute the analysis by going to Command\Get Tune Rate from Etalon or with ctrl-E. 
14)   Evaluate result.  The program marks each peak and valley that it finds with white carats 

(“^”).  There should be one and only one carat at each maximum and minimum.  If you 
see missing or extra carats, then the analysis has failed and you must start over.  The 
program also displays the result of its analysis by drawing yellow vertical lines where its 
model of the tuning rate expects to find etalon maxima and minima.  This may not be 
precisely the same as the locations of the carats but it should be close. 

15)   The new tuning rate is automatically accepted in your current Field.  If you are happy 
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with this new tuning rate, then transfer it to the other fields using either 
Command\Duplicate Tuning Rates or ctrl-u.  If you don’t like this tuning rate, you have 
the option of returning to the original tuning rate using the Command\Transfer Field 
Parameters… menu.  The original tuning rate should still be present in the other Fields. 

16)  The tuning rate derived from the etalon spectrum should be very good, but in many cases 
it is useful to perfect it in a final step.  If the spectrum in Field 1 or Field 4 contains 
multiple peaks that are fit simultaneously, then evaluate the fit to see if all peaks in the fit 
coincide with the measured peaks.  If not, this can often be improved by slightly 
stretching or shrinking the tuning rate.  This can be done using “stretch/shrink” buttons 
under the “Edit\Tuning Rate Params…” menu.  This optimization can be done in real 
time with data acquisition system in stream mode.  When you are finished, remember to 
transfer the final tuning rate to all fields. 
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Appendix K:  The Spectral Null Method  
 The Spectral Null Method is a variation of the Power Normalization method that 
improves measurement precision in some cases.  Instead of normalizing the sample spectrum 
with a spectrum obtained by directly monitoring the laser output, a spectrum that passes through 
a reference cell is employed.  Typically the reference cell contains a fixed mixing ratio of the gas 
being measured in the sample path.  By dividing the sample spectrum by the reference cell 
spectrum, one obtains a spectrum with no net absorption when the sample column density equals 
the reference column density.  This greatly reduces noise that is proportional to the mixing ratio 
as well as laser amplitude noise.  This method was developed to improve the precision of carbon 
dioxide isotope ratio measurements but it can be applied in other cases.  This method is initiated 
by checking the Null Method checkbox on the Power Normalization configuration page.  If this 
method is used, you must also provide mixing ratio values for the reference gas or gases.  This 
can be done by clicking on the Set Null Parameters button.  But what value should you use? 
 
 The reference mixing ratios that are entered into the menu are actually “effective” mixing 
ratios.  The program assumes that the path length in the reference gas cell is identical to the path 
length in the sample cell.  In some cases this will be true and the “effective” reference mixing 
ratio (MReff) will be equal to the actual mixing ratio (MRact).  However, if the path lengths are not 
the same, then the effective ratio will be: 
 

MReff  =  MRact  *  (Lr / Ls) 
  
where Lr and Ls are the optical path lengths in the reference and sample cells. Although this 
seems to completely define the required menu parameter(s), there is actually one remaining 
subtlety.  How do you select MRact? 
 
 In principle, MRact can either be a calibrated value (for example, the value specified for a 
certified gas cylinder) or it can be the value reported by TDLWintel when TDLWintel analyzes 
the reference gas by itself.   If the goal is to measure a single gas, then it does not matter very 
much which approach is used assuming that the instrument will ultimately be calibrated while in 
operation.  But for the important case of measuring isotopic ratios, it turns out that it is better to 
use the value reported by TDLWintel than the “true” value.  Typically, these values may differ 
by up to 10%.  The motivation for using the value returned by TDLWintel is explained below.   
The explanation is followed by a practical prescription for configuring the Null Method when 
measuring isotopic ratios. 
 
Concentration Independent Isotopic Ratios 

The null method has an inherent propensity to cause dilution dependent isotopic ratios.  If 
the spectroscopic retrieval (without the null method) were perfectly linear (though not 
necessarily 100% accurate) and had no significant offset at zero concentration, then it would 
yield isotope ratios that do not depend on concentration.  When the null method is introduced, 
concentration dependent isotopic ratios have the potential to appear even with perfectly linear 
instrument response.  This will happen if we choose our reference mixing ratios for each isotope 
to get the "right" mixing ratios at the null point.  Then when the concentration moves away from 
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the null point the isotopic ratio varies even when the spectroscopy is linear because we have built 
in an offset.  This is shown in Figure 1.  The red and brown traces are examples of linear 
response without offset.   This is approximately what we expect in the absence of the null 
method.  The slopes are not unity but the intercept is near zero.  The ratio of the red and brown 
traces is constant.  The blue and green traces show what we get with the null method when we 
set the reference values in TDLWintel to be the “true” values.  The correct values and ratio are 
given at the null point (400 ppm in this case), but the ratio of the two lines varies with the 
dilution at the rate of approximately 0.2 del units per ppm.  This degree of non-linearity is 
annoying.  It can be measured and corrected, but it is easier to avoid it.  We can make the real 
time isotopic ratio results have much less dependence on the sample CO2 mixing ratio if we set 
the mixing ratio reference values with this goal in mind.   
 

This is easily implemented.  If the flowing reference gas has a mixing ratio for one 
species of 400 ppm, but the spectroscopy yields 360 ppm (without the null method), then we 
enter 360 ppm into the menu rather than 400 ppm.   That is, we enter TDLWintel’s reported 
mixing ratios, not the actual mixing ratios. If we do this, then the null method gives a mixing 
ratio of 360 ppm at the null point and gives 0 when measuring zero gas.  This will provide real 
time isotopic ratios that do not depend on dilution or at least depend much less on dilution.   

 
Figure K1.  The red and brown traces show typical instrument response functions without the null method.  The 
blue and green traces show the same with the null method if the reference concentrations are chosen to give the 
truth at the null point. 
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 Appendix L:  Step by Step Guide to Measuring Dark Noise 
 
 Typically, there are multiple noise sources which contribute to the total measurement 
noise when using TDLWintel.  In order to reduce the total noise, it is generally helpful to 
characterize the observed noise.  Is it proportional to the laser intensity?  Is it proportional to the 
observed mixing ratio?  Is the noise reduced when the laser is blocked?  This latter question can 
be addressed by measuring the spectrometer’s “dark noise”, that is, the noise in the reported 
mixing ratio when the laser is blocked.  If the noise is the same with the laser blocked then we 
would describe the instrument performance as dark noise limited.  There is little point in trying 
to reduce the laser amplitude noise if the instrument is dark noise limited.  So how do you 
measure the dark noise? 
 

To measure the dark noise, we want to continue measuring the species mixing ratio while 
the laser is blocked.  This requires that we fool the program into thinking that the light is still 
present.  This is relatively straight forward for a single laser system so let’s start with that case. 

 
1) Start in Field 1. 
2)  Turn off the Power Normalization, Automatic Background, Automatic Calibration 

and Frequency Lock methods if they are on. 
3) Put the program in Current Signal mode. 
4) Note the value of the Signal Range (in the Status frame).  
5) Go to Edit\Laser Characteristics.  Type the value of the Signal Range into the 

Average Laser Power box.  Implement and Quit. 
6) Delete the fit markers that indicate where laser is suppressed during the scan.  That is, 

delete the zero markers (“o”).  This may be easier to accomplish if you put the 
program in Display mode. 

7) Block the laser. 
8) Make sure that the peak position is fixed. 
9) Enter Stream mode.   
10)   Open the Mixing Ratio vs. Time Window and click on the “Now” button. 
11)   Wait until the measurement stabilizes. 
12)   Read the average dark noise from the bottom of the Mixing Ratio window. 

 
The procedure for a dual laser instrument is slightly more complex because the laser intensities 
will be different. 

 
For a dual laser system the procedure is the following: 
 
1) Start in Field 1. 
2)  Turn off the Power Normalization, Automatic Background, Automatic Calibration 

and Frequency Lock methods if they are on. 
3) Put the program in Current Signal mode. 
4) Open the Status Report window and note the value of the Ranges for the two lasers.  

These are given in the first column (for Field 1) and are labeled “Range L1” and 
“Range L2”.     
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5) Go to Edit\Laser Characteristics.  Type the value of the Laser 1 Range into the 
Average Laser Power box.  Implement and Quit. 

6) Delete the fit markers that indicate where laser is suppressed during the scan.  That is, 
delete the zero markers (“o”).  This may be easier to accomplish if you put the 
program in Display mode. 

7) Block the laser. 
8) Make sure that the peak positions for both lasers are fixed. 
9) Enter Stream mode.   
10)   Open the Mixing Ratio vs. Time Window and click on the “Now” button. 
11)   Wait until the measurement stabilizes. 
12)   Read the average dark noise for laser 1 from the bottom of the Mixing Ratio 

window. 
13)   To measure the dark noise for laser 2, either repeat the above steps after typing the 

Laser 2 Range into the Average Laser Box or simply calculate the laser 2 dark noise 
from the ratios of the Laser Ranges.  The formula is: 
 

DN2 = DN1 * (LR1 / LR2) 
 

 where DN stands for dark noise and LR means Laser Range. 
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Appendix M:  Reporting Mixing Ratios as Analog Voltages with DACOut Function 
General Overview 
 TDLWintel uses the DACOut function to create an analog output voltage which is 
proportional to the mixing ratio of a molecule being monitored by TDLWintel.  DACOut is 
intended to have high time resolution (~10 ms) so that it can be used during Eddy Correlation 
experiments.  With earlier versions of TDLWintel, a separate program called DACOut.exe was 
used to produce the analog output signals.  This is no longer supported.  The DACOut program 
has now been integrated within TDLWintel.  
 
 DACOut converts the incoming concentrations and time stamps into a time dependent 
analog voltage which is produced by a National Instruments data acquisition board.  The output 
voltage is delayed in time with respect to the actual concentration measurement time to allow 
time for buffering of the incoming data stream.  This time delay is fixed and can be set in the 
DACOut configuration menu.  DACOut has a voltage output range of -10 V to +10 V.  This is 
not adjustable.  When DACOut starts up it puts out zero volts until the delay time passes and 
then begins producing voltages which are proportional to the species concentration.  If data is 
unavailable for a significant fraction of the delay time a data dropout will occur.  During a data 
dropout, the program reports zero volts.  This occurs until valid data is generated again. 
 
DACOut Console 
 The DACOut Console interface is accessed through the Command menu.  At the top of 
the window are two circular buttons which are used as indicators.  When DACOut is functioning 
normally, both buttons are white. If there is an error retrieving data, then the button on the left 
will turn red. The second button is used to indicate that data has been lost.  This data dropout 
button turns red if no mixing ratio data is received by the DACOut function at the time that the 
output voltage buffer needs to be updated.   
 
 Below the indicator lights are three text boxes.  The lower box reports the elapsed time 
since DACOut was started.  The other boxes report the most recent concentrations that have been 
received through the DEFT interface.  These quantities are updated every half second. 
 
 At the bottom of the window is a frame that reports the status of the voltage output 
buffer.  The first number gives number of buffers that have been put out.  The second number is 
the current position within the output buffer.  Since the buffer puts out data at 100 Hz, a 10 
second buffer will contain 1000 points. 
 
 
  
DACOut Menu 
 
 The operation of DACOut can be configured using the DACOut menu which is accessed 
under the Edit menu and shown in the Figure.  The menu is explained below. 
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1) Multiple tabs allow voltage outputs to be defined for multiple species.  Depending on the 

hardware, two to 4 output voltages will be supported. 
2) DAC number for first species.  There are two to four Digital to Analog Coverters (DACs) 

on the NI cards and any can be used.  
3) Species number for first species.  TDLWintel is capable of fitting up to 16 species.  Only 

two to four can be reported by DACOut, but any one of the (up to 16) species can be 
selected.  

4) Mixing ratios.  These parameters give the mixing ratios which will be reported as +10V 
and as -10V.  This allows the voltage range to be matched to the expected concentration 
range. 

5) Time delay.  This is the time delay between concentration measurement and the voltage 
output.  Longer time delays give more reliable performance since unexpected delays in 
the data processing can be tolerated more easily with a larger buffer.  Safe choices are 8 
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to 10 seconds. The program will accept delay times between 4 and 30 seconds. 
6) Drift correction method.  0 implies no correction for clock drift, 1 implies that corrections 

will be done on the hour and 2 implies that the program will make continuous small 
corrections. 

 
 
Time Drift Corrections 
  The DACOut program relies on a timing chip on the National Instruments board to report 
the mixing ratios as voltages with high time resolution.  Unfortunately, no clock is perfect.  
There is a small drift between the computer’s millisecond timer clock (which is used to time 
stamp the data) and the timing chip on the NI board that times the analog output signal.  These 
are synchronized when DACOut starts but if DACOut runs for long periods of times then the two 
clocks will drift out of phase.  So if a mixing ratio is measure at time T, initially the voltage will 
appear at the output at T + 8 seconds (if the time delay in DACOut is set to 8 seconds).  After 
DACOut runs for a day, the voltage might follow the measurement by 11 seconds or 5 seconds.  
These drifts are usually small but they are not zero.  Typical drift rates seem to be a few seconds 
per day. 
 

There are two problems caused by this drift.  The first is that the drift in the time delay 
can cause problems correlating with other instruments.  Since DACOut is often used to do Eddy 
covariance measurements, these correlations are crucial and must be precise.  On the other hand, 
this time lag is only one of several time lags involved in an Eddy covariance measurement.  
Hence, it is general practice to measure all lag times regularly using an autocorrelation method.  
From this point of view it is defensible to just rely on the autocorrelation and ignore the re-
synchronization options in DACOut. 

 
The second problem is that the two clocks will eventually drift so far apart that DACOut 

will fail.  This is a more compelling reason to re-synchronize the clocks frequently.  There are 
two methods of re-synchronization.  The first is to automatically resynchronize on the hour 
(method 1).  This will put a small interruption in the data stream on the hour.  But the data 
reporting rate will be constant during the hour.  Alternatively you can choose continuous small 
corrections (method 2) which are virtually un-noticeable.  With this method the program notices 
past drift and tries to account for it in future measurements.  This means that the data has the 
potential to be reported with a slightly variable clock rate.  We believe that this variation is very 
small and that method 2 is the preferred method.  
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Appendix N:  Reporting Dry Air Mixing Ratios in Presence of Water 
Variation in the concentration of water in the atmosphere will affect the mixing ratio 

reported by the Aerodyne trace gas monitor in two ways: 
 

1) The variation in water vapor concentration will vary the dilution factor that is needed 
to derive the dry air mixing ratio from the real mixing ratio. 

2) The variation in water vapor concentration will vary the pressure broadening 
coefficient that should be used to analyze the spectra since water is generally a more 
effective spectral broadening agent than either nitrogen or oxygen. 

 
Both of these effects can be corrected by TDLWintel assuming that water vapor is also being 
measured.  Given the appropriate correction factors, TDLWintel will report the correct dry air 
mixing ratio for all species even as the water vapor composition varies.  Because, the broadening 
effect varies by spectral line, we expect the required correction factors to vary with spectral line.  
Hence these correction factors must be measured for the specific spectral line that is used to 
determine the mixing ratio of each species.   
 

The software settings for the water broadening coefficients are accessed in TDLWintel 
under Edit\Water Broadening.  The menu is shown in Figure N1. 
 

 
Figure N1.  Water broadening menu. 
 
The “Water Vapor Speces Number” should be selected to indicate the species number that is 
providing the water vapor mixing ratio.  The Water Vapor Broadening Ratios are the actual 
correction factors for each species that is being corrected for the influence of water vapor.  It is 
these broadening ratios that must be determined experimentally.  The physical meaning of these 
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correction factors is that they are the ratio of water pressure broadening to dry air pressure 
broadening for the spectral line used to measure the given species.  In many cases these 
correction factors are already measured and are provided with the Aerodyne trace gas monitor.  
If you need to measure correction factors, we can provide you with a procedure that explains 
how to do so. 

 
Figures N2 and N3 show the effect of water vapor on the reported mixing ratio of nitrous 

oxide with and without the software correction for water vapor dilution and spectral broadening. 
 
 
 
 
 
 

 
Figure N3.  Effect of water vapor on nitrous oxide mixing ratio with optimal 
software correction. 

 
Figure N2.  Effect of water vapor on nitrous oxide mixing ratio with no 
software correction. 
 


